Power Mac G5
User’s Guide
Includes setup, expansion, and troubleshooting information for your Power Mac G5 computer
## Contents

### Chapter 1  Getting Started
5 Setting Up Your Power Mac G5
10 Next Steps
12 Putting Your Power Mac G5 to Sleep or Shutting It Down

### Chapter 2  Getting to Know Your Power Mac G5
13 Basic Features of Your Power Mac G5
16 Ports and Connectors on Your Power Mac G5
18 Internal Expansion Options
20 Learning About Mac OS X
20 Customizing Your Desktop and Setting Your Preferences
21 Getting Answers Using Mac Help
22 When an Application “Freezes” or Does Not Respond
23 Keeping Your Software Up to Date
23 Connecting to a Printer

### Chapter 3  Using Your Power Mac G5
25 Using Your Apple Keyboard
27 Using Your Mighty Mouse
28 Connecting Displays, Televisions, and Video Devices
30 Using Universal Serial Bus (USB)
32 Connecting With FireWire
34 Connecting Audio Devices
35 Using Your Optical Drive
37 Connecting to an Ethernet Network
39 Understanding AirPort Extreme Wireless Networking
41 Using Bluetooth 2.0+EDR Wireless Technology
43 Transferring Information Between Two Macintosh Computers

### Chapter 4  Working Inside Your Computer
45 Opening the Computer
51 Installing Memory
57 Installing Internal Storage Devices
65 Adding PCI Express Cards
Congratulations on purchasing your new high-performance Power Mac G5 computer. This chapter contains instructions for setting up your computer and display.

Your Power Mac G5 features the latest computer technology, including advanced 64-bit dual core processor technology, high-speed DDR2 memory, PCI Express graphics and expansion cards, and Serial ATA internal storage, all in an anodized aluminum chassis with easy access to internal components.

Setting Up Your Power Mac G5
Your Power Mac G5 is designed so that you can set it up quickly and start using it right away. Follow the steps on the next few pages to set up your Power Mac G5.

Before you begin, remove any protective film from the outside of your computer and from the inside of the side panel. For instructions about opening the side panel, see “Opening the Computer” on page 46.
Step 1: Position your computer and display
Pick up the computer by both of its handles using correct lifting techniques. If your display is heavy, use correct lifting techniques when positioning it as well. Position the computer and display so that:
- They are on sturdy, flat surfaces
- The power cable connectors don't press against a wall or other object
- The airflow in front of, behind, or below the display or computer is not obstructed
- The computer's optical drive tray has space to open in front

Warning: Apple recommends that you operate your Power Mac G5 in an upright position with the side panel in place. The computer does not operate properly when it is placed on its side or when the side panel is removed.

The only way to shut off power completely to your computer and display is to disconnect their power plugs from the power source. Make sure the power cords for your computer and display are within easy reach so that you can unplug the computer or display when you need to.

Step 2: Plug in the power cord
Plug the power cord firmly and completely into the recessed power cord socket on the back of the computer and plug the other end into a grounded outlet or a grounded power strip.
Step 3: Connect the display
Connect your display as shown in the illustration below. Depending on the display, you may have one or more cables to connect. Check the instructions that came with the display for additional setup information.

You can connect two displays with Digital Visual interface (DVI) connectors to the display ports on the back of your Power Mac G5.

You can connect a:
- 20- or 23-inch display, such as the 20- or 23-inch Apple Cinema Display, in either port
- 30-inch display, such as the 30-inch Apple Cinema Display, in DVI port 1

You can also connect displays that have an Apple Display Connector (ADC) or a video graphics array (VGA) connector, or you can connect a video device using one of the following display adapters:
- To connect a VGA display, use a DVI to VGA Adapter (included with your Power Mac G5) to connect the display to the DVI port.
- To connect an ADC display, use a DVI to ADC Adapter (not included) to connect the display to the DVI port.
• To connect a television, VCR, or other video device, use a DVI to Video Adapter (not included) to connect the device to DVI display port 2 (see “Connecting Displays, Televisions, and Video Devices” on page 28).

To purchase a DVI to ADC Adapter or a DVI to Video Adapter, contact an Apple Authorized Reseller, visit an Apple Store retail location, or go online to the Apple Store at www.apple.com/store. For more information about connecting a display, see the guidelines in Chapter 3, “Using Your Power Mac G5.”

**Step 4: Connect an Ethernet cable**

To access the Internet or a network, connect one end of an Ethernet cable to either of the Ethernet ports on the back of your Power Mac G5. Connect the other end to a DSL modem, cable modem, or an Ethernet network.
Step 5: Connect the keyboard and mouse
Connect the keyboard cable to one of the USB ports (\( \Diamond \)) on the computer or on your display. Plug the mouse cable into a USB port on the keyboard.

Note: If the keyboard cable is not long enough to reach a USB port on your computer, you can use the keyboard extension cable that came with your computer.

Using a Wireless Keyboard and Mouse
If you purchased an Apple Wireless Keyboard and an Apple Wireless Mouse with your Power Mac G5, follow the instructions that came with the keyboard and mouse to set them up with your computer.

Step 6: Turn on your Power Mac G5
Press the power button (\( \Box \)) on the front of the computer to turn it on. With some Apple displays, you can also turn on the computer using the display's power button. If your display must be turned on separately, turn it on by pressing its power button.
**Need Help Setting Up?**

If you don’t see anything on your screen or you think your computer did not start up properly, check the following:

- Is the computer plugged into a power source? If it’s plugged into a power strip, is the power strip turned on?
- Is the power cord securely plugged into the back of the computer?
- Are the keyboard and display cables connected correctly?
- Is the display turned on? Are the brightness and contrast controls on the display adjusted correctly? If your display has brightness and contrast controls, adjust them.
- If you still don’t see anything on your screen, restart your computer. Press and hold the computer’s power button for approximately 5 seconds until the computer turns off. Press it again to turn on the computer.
- If you see a blinking question mark on the screen or see a series of flashes from the status light when you turn on the computer, see Chapter 5, “Troubleshooting,” on page 69.

**Next Steps**

The first time you turn on your computer, Setup Assistant starts. Setup Assistant helps you enter your Internet and email information and set up an account on your computer. If you have another Mac, Setup Assistant can also help you transfer files, applications, and other information from your old Mac to your new Power Mac G5.

**Transferring Information to Your Power Mac G5**

You can use Setup Assistant to automatically transfer information from another Mac to your new Power Mac G5. To transfer information, make sure of the following:

- Your other Mac must have built-in FireWire and support FireWire Disk Mode.
- Your other Mac must have Mac OS X v10.1 or later installed.
- You must have a FireWire cable to connect the two computers.

Setup Assistant takes you through the process of transferring your information—just follow the onscreen instructions. Transferring information to your Power Mac G5 does not affect the information on your other Mac. You can transfer:

- User accounts, including preferences and email
- Network settings so that your new computer is automatically set up to work with the same network settings as your other Mac
- The Applications folder so that the applications you used on your other Mac are now on your new Power Mac G5 (you may have to reinstall some of the applications you transfer)
- Files and folders stored on your hard disk. This gives you easy access to the files and folders you used on your old Mac.
If you don’t use Setup Assistant to transfer information when you first start up your Power Mac G5, you can do it later using Migration Assistant. Open the Applications folder, open Utilities, and double-click the Migration Assistant icon.

Note: If you transfer information later using Migration Assistant, make sure FileVault is turned off on the older computer. To turn off FileVault, choose Apple () > System Preferences, click Security, and follow the onscreen instructions.

Setting Up Your Power Mac G5 to Connect to the Internet
If you didn’t transfer your user account and network settings information, Setup Assistant takes you through the process of configuring your Power Mac G5 and setting it up to connect to the Internet. For home users, Internet access requires an account with an Internet service provider (ISP) and fees may apply. If you have an Internet account, see Appendix C, “Connecting to the Internet,” on page 89 for information you’ll need to enter.

More Information
For more information about using your Power Mac G5, see the following:

<table>
<thead>
<tr>
<th>To learn about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing additional drives, memory, and cards, or changing the battery</td>
<td>Chapter 4, “Working Inside Your Computer,” on page 45.</td>
</tr>
<tr>
<td>Troubleshooting your computer if you have a problem</td>
<td>Chapter 5, “Troubleshooting,” on page 69.</td>
</tr>
<tr>
<td>Installing Mac OS 9 to use Mac OS 9 applications with your computer</td>
<td>“Installing Mac OS 9” on page 75.</td>
</tr>
<tr>
<td>Connecting your computer to the Internet</td>
<td>Appendix C, “Connecting to the Internet,” on page 89.</td>
</tr>
</tbody>
</table>
Putting Your Power Mac G5 to Sleep or Shutting It Down
When you have finished working with your Power Mac G5, you can put your computer to sleep or shut it down.

Putting Your Power Mac G5 to Sleep
If you will be away from your Power Mac G5 for only a short time, put the computer to sleep. When the computer is in sleep, the display’s screen is dark. You can quickly wake the computer from sleep and bypass the startup process.

To put the computer to sleep quickly, do one of the following:
• Choose Apple () > Sleep.
• Press the power button on the front of your Power Mac G5.
• Choose Apple () > System Preferences, click Energy Saver, and set a sleep timer.

To wake your computer from sleep, do one of the following:
• Press any key on the keyboard.
• Click the mouse.

Shutting Down Your Power Mac G5
If you will not be using your Power Mac G5 for a day or two, you should turn it off. To turn off your Power Mac G5, choose Apple () > Shut Down.

**Warning:** Do not turn off the Power Mac G5 by turning off the switch on a power strip or by pulling out the computer’s power plug (unless you can’t turn off the computer any other way). Your files or system software could be damaged if your computer is not shut down properly.

**Warning:** Shut down your Power Mac G5 before moving it. Moving your computer while the hard disk is spinning can damage the hard disk, causing loss of data or the inability to start up from the hard disk.
This chapter gives you some basic information you’ll need to know about your Power Mac G5.

Read on for an overview of the different parts of your computer and the features of Mac OS X, including information about common tasks such as customizing the way your desktop looks, getting answers when you need help, keeping your software up to date, and connecting to a printer.

Getting the Latest Information
Because Apple frequently releases new versions and updates to its system software, images shown in this book may be slightly different from what you see on your screen.

The Apple website, at www.apple.com, links you to the latest Apple news, free downloads, and online catalogs of software and hardware for your Power Mac G5.

You can also find the manuals for many Apple products and technical support for all of Apple's products on the Service and Support website at www.apple.com/support.
Basic Features of Your Power Mac G5

- Optical drive
- Headphone jack
- Power button
- Status light
- FireWire 400 port
- USB 2.0 port
Optical drive
Your Power Mac G5 has a DVD+R DL/DVD±RW/CD-RW SuperDrive, which can read CD-ROM discs, photo CDs, standard audio discs, DVD discs, and DVD movies. The SuperDrive can write music, documents, and other digital files to CD-R and CD-RW discs, DVD±R, DVD±RW, and DVD+R Double Layer (DL) discs.
To open the optical drive, press the Media Eject (⏏) key on your Apple Keyboard.

Status light
A white light indicates that the computer is on; a pulsing light indicates the computer is in sleep.

Power button
Press this button to turn on your Power Mac G5, put it to sleep, or wake it from sleep. To restart your computer, press and hold this button for approximately 5 seconds until the computer turns off, then press it again to turn the computer on.
With some Apple displays, you can also touch or press the display's power button to put the computer to sleep.

FireWire 400 port
Connect your Macintosh to FireWire devices (including digital videocameras and hard disk drives). FireWire provides high-speed data transfer for them all. The FireWire 400 port supports data rates of 100, 200, and 400 megabits per second (Mbps).

Headphone jack
Connect headphones to your Macintosh through the headphone jack. When a plug is inserted into the headphone jack, the built-in speaker is muted.

USB 2.0 port
Connect your Macintosh to USB devices, such as keyboards, mice, printers, scanners, speakers, USB microphones, and USB hubs. Your display may also have USB ports.
Ports and Connectors on Your Power Mac G5

Latch

DVI display port 2

Integrated Bluetooth, and AirPort antenna

FireWire 800 port

FireWire 400 port

Audio line-out port

Audio line-in port

Access covers for PCI Express expansion slots

DVI display port 1

Gigabit Ethernet ports (2)

Optical digital audio out port

Optical digital audio in port

USB 2.0 ports (3)

Power socket
Latch
Lift the latch to open the side panel and access the internal components in your Power Mac G5. You can also attach a security lock to the latch to secure the internal components.

DVI display ports
Connect displays that use a Digital Visual Interface (DVI) connector to the DVI display ports. You can connect a display, such as the 20- or 23-inch Apple Cinema Display, to either display port. You can connect a 30-inch display, such as the 30-inch Apple Cinema Display, to DVI display port 1. You can also connect displays that use a video graphics array (VGA) connector with the DVI to VGA Adapter that came with your Power Mac G5.

Integrated Bluetooth and AirPort Extreme antenna
If your Power Mac G5 has the optional Bluetooth® and AirPort Extreme technologies installed, make sure this antenna is not obstructed.

FireWire 400 and 800 ports
The FireWire 400 port supports data rates of 100, 200, and 400 Mbps. The FireWire 800 port supports data rates of 100, 200, 400, and 800 Mbps.

Analog audio line-out port
Connect self-powered analog speakers and other devices with analog output capability.

Analog audio line-in port
Connect self-powered microphones, MP3 and CD players, and other devices with analog output capability.

Access covers for PCI Express slots (3)
Expand your Macintosh by installing up to three Peripheral Component Interconnect (PCI) Express cards in the covered slots labeled 2, 3, and 4.

Gigabit Ethernet ports with jumbo frame support
Connect your Macintosh to a high-speed Ethernet network to access the Internet or network resources such as printers and servers, and share information over the network using a CAT 5e cable.

Optical digital audio out port
Connect your Macintosh to a receiver or other digital audio devices.

Optical digital audio in port
Connect your Macintosh to digital audio devices, such as CD players and minidisc players.

Three USB 2.0 ports
Connect your Macintosh to USB devices, such as keyboards, mice, printers, scanners, speakers, USB microphones, and USB hubs. Your Apple Keyboard and your display may also have USB ports.

Power socket
Connect the computer’s power cord, which is a special high-current cord. Do not use ordinary power or extension cords.
Internal Expansion Options

- Optical drive
- Bottom hard disk drive bay
- Top hard disk drive bay
- Optical drive
- Bottom hard disk drive bay
- Top hard disk drive bay
- Battery
- DDR2 SDRAM slots
- Slots 2–4: PCI Express
- Slot 1: PCI Express graphics (graphics card installed)
Optical drive
Your Power Mac G5 comes with a DVD+R DL/DVD±RW/CD-RW SuperDrive. For information about the optical drive, see “Using Your Optical Drive” on page 35.

DDR2 SDRAM slots
Your Power Mac G5 has 8 DDR2 SDRAM slots. You can add additional PC2-4200, 533 MHz memory by inserting DDR2 SDRAM DIMMs in pairs in the memory slots. For more information about installing additional memory or about the specific type of memory used in your Power Mac G5, see “Installing Memory” on page 51.

Battery
Your Power Mac G5 uses a battery. If your computer has trouble starting up, or the system date and time are frequently incorrect, you may need to replace the battery. For more information, see “Replacing the Internal Backup Battery” on page 68.

Hard disk drive bays
Your Power Mac G5 comes with a hard disk drive installed in the top hard disk drive bay. You can install an additional hard disk drive in the bottom hard disk drive bay. You can have up to two Serial ATA drives in the computer. For more information, see “Installing Internal Storage Devices” on page 57.

PCI Express slots
Your Power Mac G5 has three PCI Express expansion slots. You can install PCI cards in slots 2 through 4 to expand your computer’s capabilities. For more information, see “Adding PCI Express Cards” on page 65.

PCI Express graphics slot
Connect your display to the card in the PCI Express graphics slot. For more information, see “Connecting Displays, Televisions, and Video Devices” on page 28 or “Adding PCI Express Cards” on page 65.
Learning About Mac OS X

Your computer comes with Mac OS X “Tiger,” which includes Spotlight, an improved search engine that automatically indexes all of your files; Dashboard, an interface for putting handy “widgets” or mini-applications at your fingertips; Exposé, which tiles and neatly displays all your open applications; and much more.

When you’re ready to learn more about Mac OS X, see the Welcome to Tiger booklet that came with your Power Mac G5. Also open Mac Help and browse the information there. You can find information for new users, experienced users, and users switching to the Mac. If you have problems using Mac OS X, see Chapter 5, “Troubleshooting,” on page 69 or choose Help > Mac Help from the menu bar at the top of the screen.

For information about the software applications compatible with Mac OS X, or to read more about Mac OS X, check the Apple website at www.apple.com/macosx.

Note: If you want to use Mac OS 9 applications with your Power Mac G5, you must install a version of Mac OS 9 that supports the Classic environment (see “Installing Mac OS 9” on page 75). Mac OS 9 can’t be installed as the primary operating system on your Power Mac G5, and you can’t start up your computer in Mac OS 9.

Customizing Your Desktop and Setting Your Preferences

You can quickly make your desktop look the way you want using System Preferences. Choose Apple () > System Preferences from the menu bar.
As you get to know your computer, explore System Preferences, your command center for most settings on your Power Mac G5. For more information, open Mac Help and search for “System Preferences” or for the specific preference pane you want to change.

*Note:* Because Apple frequently releases new versions and updates to its system software, applications, and Internet sites, images shown in this book may be slightly different from what you see on your screen.

**Getting Answers Using Mac Help**

Most of the information about using your Mac is available in Mac Help.

**To open Mac Help:**

1. Click the Finder icon in the Dock (the bar of icons at the bottom of the screen).

2. Choose Help > Mac Help (click the Help menu in the menu bar and choose Mac Help).

3. Click in the search field, type a question, and press Return on your keyboard.
When an Application “Freezes” or Does Not Respond

Mac OS X provides a way to quit a frozen application without restarting your computer. Quitting a frozen application may allow you to save your work in other open applications.

To force an application to quit:

1. Press Command (⌘)-Option-Esc or choose Apple (●) > Force Quit from the menu bar. The Force Quit Applications dialog appears with the application selected.

2. Click Force Quit.

   The application quits, leaving all other applications open.

   If you need to, you can force the Classic environment to quit, which closes all Classic applications. You can also restart the Finder from this dialog.

   If you’re experiencing other problems with an application, see Chapter 5, “Troubleshooting,” on page 69.
**Keeping Your Software Up to Date**

You can connect to the Internet and automatically download and install the latest free software versions, drivers, and other enhancements from Apple.

When you are connected to the Internet, Software Update checks Apple's Internet servers to see if any updates are available for your computer. You can set your Mac to check the Apple servers periodically and download and install updated software.

**To check for updated software:**
1. Open System Preferences.
2. Click the Software Update icon and follow the directions on the screen.

   ![Software Update](image)

• For more information, search for “Software Update” in Mac Help.
• For the latest information about Mac OS X, go to the Mac OS X website at www.apple.com/macosx.

**Connecting to a Printer**

Follow the instructions that came with your printer to install any required software and to connect the printer. The drivers for most printers are built into Mac OS X.

You can connect to most printers with a USB cable; others may require a network connection, such as Ethernet. If you have an AirPort Express or AirPort Extreme Base Station, you can connect a USB printer to the base station (instead of connecting it to your computer) and print wirelessly.

After you connect to a USB or FireWire printer, your computer usually detects it automatically and adds it to the list of available printers. You may need to know the network name or address of those printers connected to a network before you can print to them.
To set up a printer:
1 Open System Preferences and click the Print & Fax icon.
2 Click Printing and then click the Add button (+) to add a printer.
3 Select the printer you want to use, and then click Add.
4 Use the Add button (+) and the Remove button (–) to choose the printers that appear in the printer list.

Monitoring Printing
After you send a document to a printer, you can monitor printing, including halting your print job or putting it temporarily on hold. To monitor printing, click the printer icon in the Dock to open the printer window. You can now see the print jobs in the print queue and work with them.

For more information, open Mac Help and search for “printing.”
This chapter provides instructions for using the features of your Power Mac G5 computer, including your keyboard; mouse; audio and networking features; and USB, FireWire, AirPort and Bluetooth technologies.

Look for important information in the following sections:
- “Using Your Apple Keyboard” on page 26
- “Using Your Mighty Mouse” on page 27
- “Connecting Displays, Televisions, and Video Devices” on page 28
- “Using Universal Serial Bus (USB)” on page 30
- “Connecting With FireWire” on page 32
- “Connecting Audio Devices” on page 34
- “Using Your Optical Drive” on page 35
- “Connecting to an Ethernet Network” on page 37
- “Understanding AirPort Extreme Wireless Networking” on page 39
- “Using Bluetooth 2.0+EDR Wireless Technology” on page 41
- “Transferring Information Between Two Macintosh Computers” on page 43
Using Your Apple Keyboard

Your Apple Keyboard comes with function keys preset for common tasks. Press the Media Eject (⏏) key to eject discs from the optical drive. Press the Volume Up or Volume Down keys to adjust the sound level or press the Mute key to turn sound on or off. Use the Brightness Up and Brightness Down keys to adjust the level of brightness on an Apple display.

Note: Press the F12 key on a non-Apple keyboard to eject optical discs.

The Apple Keyboard has two Universal Serial Bus (USB) 1.1 ports. You can plug your mouse cable or other USB devices into the USB ports at the back of the keyboard.

If you purchased an Apple Wireless Keyboard with your Power Mac G5, follow the instructions that came with your keyboard for more information.

More Information About Your Keyboard

Additional information about your keyboard is available in Mac Help. Choose Help > Mac Help and search for “keyboard.”
Using Your Mighty Mouse

Your Power Mac G5 comes with Mighty Mouse, which features a 360-degree clickable scroll ball with adjustable scrolling, a pair of force-sensing side buttons, and left and right buttons with touch-sensitive technology. You can set up Mighty Mouse as a one-button mouse or you can program it to enable the scroll ball, activate Exposé, or display Dashboard.

Programming Your Mighty Mouse

You can set up Mighty Mouse as a one-button mouse or program it as a multibutton mouse by using the Mouse pane of Keyboard & Mouse preferences.

To open Keyboard & Mouse preferences:
1. Choose Apple () > System Preferences.
2. Click Keyboard & Mouse, and then click Mouse.
Use the pop-up menus in the Mouse pane of Keyboard & Mouse preferences to assign the following actions to a button:

- Assign primary and secondary buttons
- Activate Exposé
- Display Dashboard
- Open Spotlight
- Switch applications
- Open applications

You can also deactivate vertical and horizontal scrolling and adjust the tracking, scrolling, and double-click speed.

**More Information About Mighty Mouse**

Additional information about programming and using your Mighty Mouse is available in Mac Help. Choose Help > Mac Help and search for “Mighty Mouse.”

**Connecting Displays, Televisions, and Video Devices**

You can connect multiple displays to your Power Mac G5 and use them at the same time. You can also connect a video device, such as a television or VCR. You need the appropriate cable for each display or device you connect.

**Connecting Multiple Displays**

When an additional display is connected, you can either have the same image appear on both displays (known as *mirroring*) or use the additional display to extend the size of the Mac OS X desktop (known as *extended desktop mode*).

You can connect a 20- or 23-inch Apple Cinema Display to either DVI port and a 30-inch Apple Cinema Display to DVI port 1.

**To use multiple displays:**

1. Turn off the displays and shut down your computer.
2. Connect the video cable from each display to the port on the graphics card.
3. Turn on the displays and start up your computer.

To adjust the displays, choose Apple () > System Preferences and click Displays. By default, your computer starts up in extended desktop mode. To work in mirroring mode, choose Apple () > System Preferences, click Displays, and choose Mirroring.
Using a Television, VCR, or Other Video Device
You can connect your Power Mac G5 to a television, VCR, projector, or other external video device using the DVI to Video Adapter. The DVI to Video Adapter is available from an Apple Authorized Reseller, an Apple Store retail location, or online from the Apple Store at www.apple.com/store.

To connect a video device:
1 Turn off the video device and shut down your computer.
2 Connect the DVI end of the DVI to Video Adapter to the DVI port on your Power Mac G5 graphics card that supports TV-out, DVI display port 2.
3 Connect the other end of the adapter to the Composite (RCA) video port or the S-video port on the TV, VCR, or projector.
4 Turn on the TV, VCR, or projector and start up your computer.

To adjust the image, choose Apple () > System Preferences and click Displays.

More Information About Displays
Additional information about using your display is available in Mac Help. Choose Help > Mac Help and search for “display.” For information about:
• Adjusting the settings for your display, choose Apple () > System Preferences and click Displays
• Connecting your display, see the setup instructions on page 7
• Troubleshooting your display, see “Problems With Your Display” on page 72
• Maintaining your display, see “Maintaining Your Display” on page 86
Using Universal Serial Bus (USB)

Your Power Mac G5 comes with three USB 2.0 ports; one on the front and two on the back. Your Apple Keyboard also has two USB 1.1 ports. You can use USB ports to connect to many types of external devices, including printers, scanners, digital cameras, microphones, game pads, joysticks, keyboards, mice, and storage devices. USB makes it easy to connect to external equipment. In most cases, you can connect and disconnect a USB device without restarting your computer.

Using USB Devices

Apple has already included software to work with many USB devices. In most cases, you do not need to install the software that came with the device. When you connect a USB device, if your Power Mac G5 cannot find the correct software, you can either install the software that came with the device or contact the device manufacturer to locate, download, and install the correct software.
Connecting Multiple USB Devices
If you want to connect more than three USB devices, you can purchase a USB hub. The USB hub connects to an open port on your computer and provides additional USB ports (usually four or seven).

*Note:* To use certain USB devices, you may need a powered USB hub.

More Information About USB
Additional information about USB is available in Mac Help. Choose Help > Mac Help and search for “USB.” You can also find information on the Apple USB website at www.apple.com/usb.

For information about USB devices available for your computer, go to the Macintosh Products Guide at www.apple.com/guide.
Connecting With FireWire

FireWire is a high-speed data transfer system that lets you easily connect and disconnect external devices—such as digital music players, digital video (DV) cameras, printers, scanners, and hard disk drives. You can connect and disconnect FireWire devices without restarting your computer.

Your computer includes three external FireWire ports.

- Two FireWire 400 ports, one on the front and one on the back, support a maximum data rate of up to 400 megabits per second (Mbps).
- One high-speed FireWire 800 port on the back supports a maximum data rate of up to 800 megabits per second (Mbps). This port has a 9-pin connector and can be connected to 4-pin, 6-pin, or 9-pin FireWire devices.
Using FireWire Devices

With FireWire you can:

- Connect a FireWire digital videocamera and capture or transfer high-quality video directly to or from your computer. Then use video-editing software such as iMovie to edit the video.

- Connect an external FireWire hard disk drive to back up data or transfer files. A disk drive with the FireWire icon appears on your desktop after you connect the hard disk drive to your Power Mac G5. Some FireWire hard disk drives get their power through the FireWire cable, so you don’t need to connect to an external power supply.

- If you have a problem with your computer that prevents you from starting up, or you want to transfer files, you can use FireWire to connect your Power Mac G5 to another computer so that your Power Mac G5 appears as an external hard disk on the other computer (a feature known as FireWire Target Disk Mode). See “FireWire Target Disk Mode,” next, for more information.

To use a FireWire device, connect the device to the computer and install any software that came with the device. Your computer automatically detects when you connect a new device.

To start up from a FireWire hard disk that has Mac OS X on it, choose Apple () > System Preferences, click Startup Disk, and select the FireWire hard disk.

If your FireWire hard disk doesn’t appear or can’t be selected, consult the FireWire hard disk vendor for updated software drivers.

To disconnect your FireWire hard disk safely, drag its icon to the Trash before disconnecting the FireWire cable.

Using FireWire Target Disk Mode

If you want to transfer files between your Power Mac G5 and another FireWire-equipped computer, or you have a problem that prevents your computer from starting up, you can use FireWire Target Disk Mode to connect your Power Mac G5 to another computer.

Note: Your Power Mac G5 can operate in FireWire Target Disk Mode if the other computer is running any version of Mac OS X or Mac OS 9 with FireWire version 2.3.3 or later installed. Use System Profiler (located in Applications/Utilities) to check the version of FireWire installed. If the other computer has an older version, check for an update on the Service & Support website at www.apple.com/support.

To connect your Power Mac G5 in FireWire Target Disk Mode:

1. Shut down your Power Mac G5.

2. Use a FireWire cable with the appropriate 6- or 9-pin connector on each end to connect your computer to another FireWire-equipped computer.
3 Start up your Power Mac G5 and immediately hold down the T key.
   Your Power Mac G5 display shows the FireWire disk mode indicator, and the Power Mac
   G5 internal hard disk icon appears on the other computer’s desktop.
4 Drag the Power Mac G5 hard disk icon to the Trash on the other computer when you
   have finished transferring files.
5 Press the power button on the Power Mac G5 to shut it down.
6 Disconnect the FireWire cable.

**More Information About FireWire**
More information about FireWire is available on the Apple FireWire website at
www.apple.com/firewire. You can also find information in Mac Help. Choose Help >
Mac Help and search for “FireWire.” For information about the FireWire devices available

**Connecting Audio Devices**
Your Power Mac G5 comes with comprehensive audio capabilities, including a
headphone jack on the front and optical digital audio out, optical digital audio in,
analog audio line-out, and analog audio line-in ports on the back.

**Optical Digital Audio Ports**
You can use a digital optical or Toslink cable to connect Digital Audio Tape (DAT) decks
or CD players to the optical digital audio in port and input and mix your own music.

You can also connect an audio or AV receiver to the optical digital audio out port and
set up a Power Mac G5–based home theater system.
**Headphone Jack**
You can plug headphones into the computer’s headphone jack. When a plug is inserted into this jack, your internal built-in speaker is muted.

*Important:* Do not plug line-out devices into the headphone jack. Use the analog line-out port on the back instead.

**Analog Audio Ports**
You can connect external microphones or other audio equipment to the analog minijacks on the back of the computer. Use the Sound pane of System Preferences to select the audio input or output device you want to use.

**Using Your Optical Drive**
Your Power Mac G5 comes with a SuperDrive. You can install or use software from CDs or DVDs using your optical drive. You can play multimedia on CD discs and music from audio CDs, and write music, documents, and other digital files to CD-R and CD-RW discs. You can also play DVD movies and use most DVD discs.

You can also burn your home movies to make video DVDs that can be played in most home DVD players, or you can save documents or other digital files to blank DVD-R, DVD-RW, DVD+R, DVD+RW, and DVD+R Double Layer (DL) discs using the Finder or iDVD. You can store nearly twice as much data (8.54 GB) on a DVD+R DL disc.

*Note:* If you have older software that comes on floppy disks, contact the software manufacturer to see if the software is available on a CD, or purchase an external USB floppy disk drive for an Power Mac G5 from an Apple Authorized Reseller, an Apple Store retail location, or online from the Apple Store at www.apple.com/store.

**Inserting a Disc**
To install or use programs from a CD or DVD:
1. With the computer turned on, press the Media Eject (⏏) key on your Apple Keyboard to open the drive.
2. Place a disc in the tray, with the label facing up, and make sure the disc is lying flat.
3. Press the Media Eject (⏏) key again or gently push the tray into close it.

When the icon for the disc appears on the screen, the disc is ready to use.

**Ejecting a Disc**
You can eject a disc by dragging the disc icon to the Trash, or by pressing the Media Eject (⏏) key on your Apple Keyboard. You can also eject a disc by holding down the mouse button while restarting your computer.
Recording Information on a CD

Your optical drive can record your favorite music, programs, and files on CD-R and CD-RW discs. Create your own music CDs and play them on most standard audio players. You can also record data files, such as applications, documents, or other digital files, on a recordable CD.

With a CD-R (CD-recordable) disc, you can record information on the disc once. Although you can't change the recorded information, you may be able to add more information until the disc is full, depending on the application you use. See the documentation that came with your application for specific information about recording on your CD-R disc. It is best to use CD-R discs for recording audio CDs, because your audio CD player may not read CD-RW (CD-rewritable) discs.

With a CD-RW disc, you can save and change information on your CD multiple times. However, some software for recording media files on CDs can record data on the disc only once.

To record music on a CD-R disc from your iTunes library:
1. Open iTunes (click its icon in the Dock).
2. Select the playlist you want to record.
3. Insert a blank CD-R disc.
4. Click Burn CD at the top of the iTunes window.

For information about how to use iTunes to record music files on a CD, see iTunes Help. Open iTunes (in Applications) and choose Help > iTunes and Music Store Help.

To record data on a CD-R disc from the Finder:
1. Insert a blank CD-R disc.
2. In the dialog that appears, enter a name for the disc and select the format you want. An icon for the CD appears on the desktop.
3. Double-click the CD icon, then drag files and folders to it.
4. Choose File > Burn Disc or select the disc and drag it to the Burn Disc icon in the Dock.

Recording Information on a DVD

You can record your own digital movies on a blank DVD-R, DVD-RW, DVD+R, DVD+RW, or DVD+R DL disc. You can also record other kinds of digital data (for example, you can back up your files to DVDs).

To record data to a blank DVD:
2. In the dialog that appears, enter a name for the disc and select the format you want to create. An icon for the DVD appears on the desktop.
3. Double-click the DVD icon and drag files and folders to it.
4 Choose File > Burn Disc or select the disc and drag it to the Burn Disc icon in the Dock.

With applications such as iDVD or DVD Studio Pro, you can create your own customized DVD project, burn it on a blank DVD disc, and play it on most standard DVD players.

For more information about iDVD, open iDVD (in Applications) and choose Help > iDVD Help.

Connecting to an Ethernet Network

Your computer comes with two built-in Gigabit Ethernet ports with jumbo frame support. You can use either port to connect to a network or to a cable or digital subscriber line (DSL) modem. You can connect to most networks and servers using Category (Cat) 5e Ethernet cable.

Connecting to a network gives you access to other computers. You may be able to store and retrieve information; use network printers and electronic mail; or connect to the Internet. You can also use Ethernet to share files between two computers or set up a small network.

If you're connecting to an existing network, get information about the network and the network software you need from a network administrator who oversees its operation. Identify your organization's network administrator before you begin.

Connecting to a Twisted-Pair Ethernet Network

You can connect directly to a 10/100/1000 twisted-pair Ethernet network.

Note: You can also connect your computer to an Ethernet network that uses thin coaxial cables. To do this, you need an RJ-45–to–thin coax adapter (available from other manufacturers). Visit an Apple Authorized Reseller for more information about Ethernet media adapters.
To connect your Macintosh to an Ethernet network:
1 Plug one end of an RJ-45 twisted-pair cable into the Ethernet port on your Macintosh.
2 Plug the other end of the cable into an RJ-45 wall outlet or external Ethernet hub or switch that is connected to a twisted-pair Ethernet network.

After you start up your Power Mac G5, configure the software for your network connection. Your network administrator can provide the necessary information. You can also find information in Mac Help (choose Help > Mac Help).

To configure your network settings:
1 Choose Apple () > System Preferences and click Network.
2 Choose Built-in Ethernet from the Show pop-up menu.
3 Click TCP/IP and enter information about your network. (The default setting is Configure Using DHCP)
4 Click Apply Now.
Connecting to Multiple Networks
You can use both Ethernet ports if you want to connect to more than one network. For example, use one port to connect to a public network and the other port to connect to a private network. You need an Ethernet cable for each network.

To connect your Macintosh to multiple networks:
1. Plug one end of each Ethernet cable into an Ethernet port on your Macintosh.
2. Plug the other end of each Ethernet cable into the Ethernet port for each network.
3. Follow the instructions on page 38 to configure the network settings for each port.

Note: When you configure your network settings, make sure you configure the appropriate Ethernet port.

More Information About Ethernet
Information about setting up an Ethernet network or transferring files using Ethernet is available in Mac Help. Choose Help > Mac Help and search for “Ethernet” or “network.”

For more information about connecting your Power Mac G5 to a network, go to the Service & Support website at www.apple.com/support.

For information about networking products you can use with your Power Mac G5, go to the Macintosh Products Guide at www.apple.com/guide.

Understanding AirPort Extreme Wireless Networking
AirPort offers an easy and affordable way to provide wireless Internet access at home, at work, or in the classroom. If you ordered AirPort Extreme technology (also called WiFi or 802.11b/g) when you purchased your Power Mac G5, it is already installed.

Note: If your Power Mac G5 doesn't include AirPort Extreme technology, you can have it installed by an Apple Authorized Service Provider or at an Apple Store retail location.

Instead of traditional cables, AirPort uses wireless local area network (LAN) technology for wireless communication between multiple computers. Through a wireless network, you can set up access to the Internet, transfer files, play multiplayer games, and more.

Wireless Network Connections
With AirPort Extreme technology, you can:
• Connect your Power Mac G5 to a computer network that has wireless access
• Provide network access for other computers that use wireless cards
• Establish a wireless connection and share information with another computer that has an AirPort Card, an 802.11b wireless card, or an 802.11g wireless card

Note: Check with your network administrator for more information about reaching the network's wireless access point.
How AirPort Provides Wireless Internet Access

With AirPort, you set up a wireless connection to a device known as a base station, which has a physical connection to the Internet. AirPort technology works like a cordless telephone. The handset of the cordless phone makes a wireless connection to the base, which is connected to the telephone line. Similarly, your computer makes a wireless connection to the base station, which is connected to the telephone line or your Ethernet network.

Note: The AirPort Extreme technology in your Power Mac G5 is compatible with all versions of the AirPort Base Station.

Important: Several kinds of objects placed near the computer can cause interference. See the instructions that came with your AirPort Express or AirPort Extreme Base Station to learn about avoiding interference. For more information, go to the Service & Support website at www.apple.com/support.

More Information About AirPort

To purchase an AirPort Express or AirPort Extreme Base Station, contact an Apple Authorized Reseller, visit an Apple Store retail location, or go online to the Apple Store at www.apple.com/store.

For more information about AirPort, search for “AirPort” in Mac Help. You can also find information on the Apple AirPort website at www.apple.com/airport.
Using Bluetooth 2.0+EDR Wireless Technology

With Bluetooth® 2.0+ enhanced data rate (EDR) wireless technology, your Power Mac G5 can connect to and transfer information to devices that use Bluetooth® wireless technology, such as mobile phones, PDAs, printers, and the Apple Wireless Keyboard and Mouse (available for purchase at an Apple Authorized Reseller, an Apple Store retail location, or from the online Apple Store at www.apple.com/store). If you ordered Bluetooth technology when you purchased your Power Mac G5, it is already installed.

**Note:** If your Power Mac G5 doesn’t include Bluetooth technology, you can have it installed by an Apple Authorized Service Provider or at an Apple Store retail location.

Bluetooth wireless technology eliminates the need for many cables that traditionally connect devices together. Bluetooth enabled devices can connect to each other wirelessly at distances up to 10 meters (33 feet).

With Bluetooth wireless technology, you can do the following:

- Use a Bluetooth wireless keyboard, mouse, printer, or headset.
- Synchronize data between your Power Mac G5 and Bluetooth enabled PDA or mobile phone. You can perform a hot-sync operation or send your business card, address book, or calendar directly to a colleague’s PDA or mobile phone.
- Exchange files between Bluetooth enabled computers and devices, even Mac to PC. Apple still recommends the use of AirPort Extreme wireless networking, however, for anything but the smallest files.

**Setting Up a Bluetooth Device**

Before you can use a Bluetooth enabled device with your Power Mac G5, you need to set up the device to work with your computer. After you set up the device, it is “paired” with your computer, and you can view the device in the Devices pane of Bluetooth preferences. You need to pair your computer with a device only once, and it will remain paired with that device until you delete the pairing.

**To set up a Bluetooth device:**

1. Choose “Set up a Bluetooth device” from the Bluetooth status menu (◊) in the menu bar.
2. Follow the onscreen instructions for the type of device you want to set up.
   
   **Important:** If the Bluetooth status menu (◊) is not in the menu bar, open System Preferences and click Bluetooth. Click Settings and then select “Show Bluetooth status in the menu bar.”

**To delete a pairing with a device:**

1. Open System Preferences and click Bluetooth.
2. Click Devices and select the device from the list.
3. Click Delete Pairing.
Setting Up Bluetooth File Exchange
You can control how your computer handles files that are exchanged between Bluetooth devices. You can choose:

- To accept or refuse files sent to your computer
- Which folder to use for the files you accept from other devices
- Which folder other devices can browse
- Which applications to use with the files you accept

To set up a Bluetooth File Exchange:
1 Open System Preferences and click Bluetooth.
2 Click Sharing.
3 Select the On checkbox for Bluetooth File Exchange, and use the pop-up menus to adjust the settings.

Note: Select the “Require pairing for security” checkbox to secure File Exchange transactions and require password authentication before files can be transferred.

Sending a File to a Bluetooth Device
Your computer can send files to other Bluetooth devices in range of your computer. If your computer is not paired with the device, you may have to authenticate with it before you can send the file. If you have already paired your computer with the device, you should not have to authenticate with it again.

To send a file to a Bluetooth device:
1 Choose Bluetooth status menu (◊) > Send File.
2 Select the file you want to send, then click Send.
3 Choose a device from the Device list, then click Send.

If the device is not in the Device list, click Search. When the device is found, you can add it to your Favorites list.

More Information About Bluetooth Wireless Technology
If your computer came with a built-in Bluetooth module, you can find help by opening the Bluetooth File Exchange application (located in the Utilities folder within the Applications folder) and choosing Help > Bluetooth Help. You can also find information on the Apple website at www.apple.com/bluetooth.

Note: If you did not order Bluetooth technology with your Power Mac G5, you can have it installed by an Apple Authorized Service Provider or at an Apple Store retail location. You can also purchase an external Bluetooth USB adapter from an Apple Authorized Reseller, an Apple Store retail location, or online from the Apple Store at www.apple.com/store.
Transferring Information Between Two Macintosh Computers

If two Macintosh computers are not connected by an Ethernet, AirPort, or Bluetooth network, you can transfer information between them by connecting them with a standard Cat 5 Ethernet cable (in effect creating a small network of just two computers). You can buy this type of cable from an Apple Authorized Reseller. You connect the cable to each computer’s Ethernet port and then turn on file sharing on both computers. You can also configure the Ethernet settings on two computers to create a small network.

First, turn on file sharing on both computers:
1. Choose Apple () > System Preferences.
2. Click Sharing, then click Start.

Next, follow these steps on one computer:
1. Choose Go > Connect to Server.
2. Click Local Network.
3. Select the computer you want to access.

For more information about configuring Ethernet, search for “Ethernet” in Mac Help.

If you have an AirPort or Bluetooth wireless network, you can also transfer information between two Macintosh computers. For more information about AirPort or Bluetooth wireless networks, search for “AirPort” or “Bluetooth” in Mac Help.

You can also connect two Macintosh computers using a FireWire cable. You can then use FireWire Target Disk Mode to transfer files from one computer to another. For more information, see “Using FireWire Target Disk Mode” on page 33.

You can set up your computer to connect to other computers over FireWire, using the Internet Protocol (IP). For more information, search for “IP over FireWire” in Mac Help.

If you have an Internet connection, you can transfer files via the Internet to your .Mac iDisk, where you or another Mac user can download the files.
Use the information in this chapter to customize and expand your Power Mac G5 to fit your needs.

This chapter provides information and instructions about working inside your computer and includes information about important procedures in the following sections:

- “Opening the Computer” on page 46
- “Installing Memory” on page 51
- “Installing Internal Storage Devices” on page 57
- “Adding PCI Express Cards” on page 65
- “Replacing the Internal Backup Battery” on page 68

**Warning:** Apple recommends that you have an Apple-certified technician install memory, PCI Express cards, and internal storage devices. Consult the service and support information that came with your computer for instructions about how to contact an Apple Authorized Service Provider or Apple for service. If you install these items yourself, you risk damaging your equipment, and such damage is not covered by the limited warranty on your computer. See an Apple Authorized Reseller or Apple Authorized Service Provider for additional information about this or any other warranty question.
Opening the Computer

1 Before you open your computer, shut it down by choosing Apple () > Shut Down.

⚠️ Warning: Always shut down your Power Mac G5 before opening it to avoid damaging its internal components or the components you want to install. Do not open the computer or attempt to install items inside it while it is on.

2 Wait 5 to 10 minutes to allow the computer’s internal components to cool.

⚠️ Warning: After shutting down your computer, the internal components can be very hot. Let the computer cool down before continuing.

3 Touch the metal on the outside of the Power Mac G5 to discharge any static electricity from your body.

⚠️ Important: Always discharge static before you touch any parts or install any components inside the computer. To avoid generating static electricity, do not walk around the room until you finish installing the cards, memory, or internal storage device and close the computer.
4 Unplug all the cables and the power cord from the computer.

**Warning:** To avoid damaging its internal components or the components you want to install, always unplug your Power Mac G5. Do not attempt to install items inside the computer while it is plugged in.

5 Hold the side panel and lift the latch on the back of the computer.
6 Remove the side panel.

*Important:* When you remove the side panel, hold it securely.

*Important:* When you remove the side panel, pull the top of the side panel away from the computer, and then lift it up and remove it from the computer.
7 Remove the air deflector and place it on a soft, clean cloth.

*Important:* Always remember to replace the air deflector after you finish working inside your computer. Your computer does not function properly without the air deflector in place.
8 Pull the front fan assembly out of the computer, and then set it aside.

*Important:* When you remove the fan assembly, the metal divider panel at the top of the assembly may offer some resistance. Pulling the fan slightly away from this divider makes it easier to remove.

*Note:* You do not need to remove the front fan assembly to replace or install optical or hard disk drives or PCI Express cards.
Installing Memory

Your Power Mac G5 has eight memory slots (in two banks of four each). You can install additional synchronous dynamic random-access memory (SDRAM) in packages called dual inline memory modules (DIMMs) in the memory slots. Your computer comes with a minimum of 512 MB of random access memory (RAM), installed as a pair of 256 MB DIMMs in two of the DIMM slots. You can install additional pairs of DIMMs in the open DIMM slots.

DIMMs must be installed in equal-sized pairs and fit these specifications:
- PC2-4200, 533 MHz, Double-Data-Rate 2 (DDR2) DIMMs, also known as DDR2-533
- 64-bit wide, 240-pin modules
- 18 memory devices maximum per DIMM
- Conform to JEDEC specification (see note below)
- Nonparity
- Error-correcting code (ECC) or no error-correcting code (NECC) modules. Do not mix ECC and NECC memory modules within a pair.
- Unbuffered (not registered or buffered)
- Maximum height of 1.25 inches

**Important:** DIMMs from older Macintosh computers are not compatible with and do not fit in your Power Mac G5.

**Note:** When purchasing DIMMs for use in Macintosh computers, make sure that the memory vendor conforms to the Joint Electron Device Engineering Council (JEDEC) specification. Check with your memory vendor to ensure that the DIMMs support the correct timing modes and that the Serial Presence Detect (SPD) feature has been programmed properly, as described in the JEDEC specification. To check the compatibility of your DIMMs, see the Macintosh Products Guide on Apple’s website at www.apple.com/guide. You can purchase Apple-branded memory online from the Apple Store at www.apple.com/store.
To install memory:

1. Open your computer and remove the side panel, air deflector, and fan assembly following the directions that begin on page 46.

   The SDRAM DIMMs must be installed in pairs with one DIMM per bank.

   ![Diagram of computer interior](image)

   Install additional DIMMs in these two slots first.
   DINMs are already installed in these two slots.
   If slots are available, and you want to install more memory, install additional DIMMs in a similar fashion: In pairs, one per bank, from the center outward.

2. Locate the DIMM slots in the computer.

   **Important:** Always install DIMMs in pairs of equal size and specification, and in the order described in the illustration above.
3 Open the ejectors on the DIMM slots by pushing them out to the sides.  
**Important:** Do not touch the DIMM connectors. Handle the DIMM only by the edges.

4 Placing one hand on the back of the computer for support, align the first DIMM in the slot and push both ends of the DIMM down until the tabs are vertical and the ejectors snap into place.  

**Note:** If it is easier, you can lay your Power Mac G5 down to install memory. Place a soft, clean cloth on the desk or work surface to avoid scratching the work surface or your Power Mac G5.

5 Align the second DIMM in the opposite slot and push until the ejectors snap into place.

---

**DDR2 SDRAM DIMM**  
(Your DIMM’s shape and components may vary.)

The DDR2 SDRAM DIMM fits into the slot only one way. Align the notch in the DIMM with the small rib inside the slot. With the ejectors open (as shown), push the DIMM until it snaps into place. The ejectors close automatically.

- **Connectors**  
- **Notch**  
- **DDR2 SDRAM slot**

**Rib (inside slot)**

---

To make sure the DIMMs are properly seated in their slots, place one hand behind the computer and hold the computer so that it does not move. With your other hand, press each DIMM firmly into its slot.
6 Replace the front fan assembly by firmly pushing it back into the computer by the handle until it connects.

*Important:* Make sure the fan assembly slides into the sheet metal divider at the top and engages the connector, as shown in the illustration, or your computer will not operate properly. Gently pull the fan assembly to see if it is properly connected. If it resists and stays in place, it is connected.
7 Replace the air deflector.

*Important:* Always remember to replace the air deflector. Your computer does not function properly when the air deflector is not in place.

*Important:* Always remember to replace the air deflector. Your computer does not function properly when the air deflector is not in place.

Slide the three tabs on the air deflector into the slots in the computer and then push the air deflector closed.
8 Replace the side panel.

*Important:* Always replace the side panel before you start up your computer. Your computer does not function properly when the side panel is not in place.

Place the side panel into the slot in the computer and then push the side panel closed.
9 Push the latch down to close and secure the side panel.

**Important:** When you replace the side panel, hold it securely so that it stays in place as you push the latch down.

### Installing Internal Storage Devices

Your Macintosh has three internal drive bays: one optical drive bay and two hard drive bays. In most configurations, a single hard disk drive occupies the top hard drive bay and an optical drive is located in the front optical drive bay.

You can add a Serial ATA hard disk drive to the empty slot in the hard drive bay. The drives must meet these specifications:

- **Type:** Serial ATA
- **Width:** 3.9 inches (102 mm)
- **Depth:** 5.7 inches (147 mm)
- **Height:** 1.0 inch

For more information about requirements and devices supported, visit an Apple Authorized Reseller or the Service & Support website at www.apple.com/support.

**Important:** Use the original Apple cables that came with your Power Mac G5 when you install or replace optical drives or Serial ATA hard disk drives.
Installing Serial ATA Drives
Your Macintosh can accommodate one additional internal 1-inch-high Serial ATA drive in the hard drive bay, for a total of two drives. Your computer comes with one Serial ATA drive installed, and it usually sits in the top hard drive bay. You can install a second Serial ATA drive in the lower hard drive bay.

To install a hard disk drive:
1 Open your computer and remove the side panel following the directions that begin on page 46.

![Diagram of drive installation](image)

Install the four drive guides into four of the threaded holes on the side of the drive. If you have a choice, use holes that are closest to the corners of the drive.

2 Unscrew the four drive guides from the left side of the hard drive bay and screw them to the threads at the sides of the hard drive as illustrated above.

**Important:** If the printed circuit board (PCB) is exposed on the bottom of the hard disk drive, hold the drive by its sides. To avoid damaging the drive, take care not to touch the PCB during installation.

3 To install an additional drive in the lower drive bay:
   - Slide the drive into the lower drive bay
Align the drive guides into the bottom track and gently push the drive into the bay until it stops.

4 To replace the drive in the top drive bay:
   - If a hard drive is installed in the lower drive bay, remove it before replacing the hard drive in the top drive bay.
   - Pull the original drive out of the drive bay by dropping it down slightly until it clears the drive bay.
   - Slide the replacement drive into the top drive bay, aligning the front drive guides with the middle track.
   - Engage the rear drive guides in the top track as the drive moves into the drive bay and gently push the drive into the bay until it snaps into place.

To install a replacement drive in the top drive bay, engage the front drive guides in the middle track and push the drive in. Engage the rear drive guides in the top track as the drive moves upward into the bay. Slide the drive in until it stops and secure it with the top drive bay tab.

Connect the power cable and the smaller data cable to the hard disk drive.
5 Pull the appropriate drive bay tab down to secure the drive.
6 Connect the power cable and the Serial ATA data cable to the drive, as shown in the illustration.

7 Replace the side panel, following the directions that begin on page 56.

Replacing the Optical Drive
Your computer comes with a SuperDrive. Follow these instructions to replace the SuperDrive drive in the optical drive bay.

Important: Contact your drive manufacturer or consult the manufacturer’s website to determine if your drive is set for cable select mode. Before installation, set the drive to cable select if the manufacturer hasn’t already done so.

1 Open your computer and remove the side panel following the directions that begin on page 46.
2 Disconnect the optical drive ribbon cable from the logic board.

Disconnect this cable from the main logic board in preparation for removing the optical drive.

3 Push the optical drive release levers out to release the drive.

Swing open the two optical drive release levers.
4 Carefully pull the drive a short distance out of the bay.

5 Disconnect the ribbon cable from the back of the original drive and gently pull the cable through the opening in the sheet metal divider at the back of the optical drive bay.

6 Place two or three fingers through the opening at the back of the optical drive bay and push the drive out slightly so that you can remove it from the computer.

7 Remove the power cable from the drive.

8 Unscrew the four optical drive guide pins from the bottom of the original drive and attach them to the bottom of the replacement drive.

9 Remove the metal shield from the front of the drive and attach it to the front of the replacement drive.
10 Carefully remove the ribbon cable from the top of the original drive and transfer it to the replacement drive.

*Important:* Reusable adhesive tape on the underside of the ribbon cable attaches the cable to the drive. When removing the cable from the original drive, be careful to keep the tape with the cable.

11 Attach the ribbon cable connector and the power cable to the back of the replacement drive.

12 Insert the drive part way into the drive bay and bend the free end of the ribbon cable, then pull it down through the opening in the sheet metal divider at the back of the optical drive bay.
13 Slide the drive the rest of the way into the drive bay, aligning the optical drive guide pins in the slots, and gently push the drive into place.

14 The optical drive release levers should close when the drive is installed correctly. If they don't close, gently push them.

15 Attach the optical drive ribbon cable to its connector on the logic board.

16 Replace the side panel, following the directions that begin on page 56.
Adding PCI Express Cards
You can expand the capabilities of your Power Mac G5 by installing cards in the Peripheral Component Interconnect (PCI) Express slots. Your Power Mac G5 has four PCI Express slots that accommodate PCI Express cards and PCI Express graphics cards.

About PCI Express Cards
Your Power Mac G5 comes with a high-performance 16-lane (or 16x) PCI Express graphics card. This card, which contains the graphics processor unit (GPU) and provides the computer’s display ports, is installed in slot1.

You can install additional PCI Express cards in any of the slots. Before installing a card, check the specifications to make sure it can operate in your Power Mac G5.

**Important:** Combined maximum power consumption for all four PCI Express slots must not exceed 200 watts (W). The total combined maximum video random access memory (VRAM) for all graphics cards is 1 GB (for example, you can install one 512 MB VRAM card and two 256 MB VRAM cards for a total of 1 GB of VRAM).

Although all slots can accommodate PCI Express cards that have up to 16 lanes, if you install a card that requires a greater bandwidth than the slot provides, the card will operate at the bandwidth of the slot. For example, an 8x card installed in a 4x slot, will operate as a 4x card. Refer to the table below.

<table>
<thead>
<tr>
<th>PCI Express Slot</th>
<th>Bus Bandwidth</th>
<th>Connector size</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>4-lane (4x)</td>
<td>16-lane</td>
</tr>
<tr>
<td>3</td>
<td>8-lane (8x)</td>
<td>16-lane</td>
</tr>
<tr>
<td>2</td>
<td>4-lane (4x)</td>
<td>16-lane</td>
</tr>
<tr>
<td>1</td>
<td>16-lane (16x)</td>
<td>16-lane</td>
</tr>
</tbody>
</table>
When you install additional cards, install the highest bandwidth card in slot 3. Follow these guidelines: Install a second PCI Express card in slot 3, a third in slot 4, and a fourth in slot 2. This takes advantage of the bus bandwidth of each slot.

**Installing Your Card**

You can install PCI Express graphics and expansion cards in slots 1 through 4.

*Note:* If it is easier, you can lay your Power Mac G5 down to install PCI Express cards. Place a soft, clean cloth on the desk or work surface to avoid scratching the work surface or your Power Mac G5.

**To install a PCI Express card:**

1. Open the computer and remove the side panel and air deflector (see page 46).

⚠️ **Warning:** To avoid damaging its internal components or the components you want to install, always turn off and then unplug your Power Mac G5. Wait 5 to 10 minutes for it to cool down. Do not attempt to install items inside it while it is plugged in.

2. Remove the screw in the port access cover, pull out the access cover, and set it aside.

3. Remove the card that you want to install from its static-proof bag and hold it by its corners, taking care not to touch the gold connector or the components on the card.
4 Align the card's connector with the expansion slot and press until the connector is inserted all the way into the slot.

If you're installing a 12-inch card, make sure the card engages the appropriate guide.

Press the card gently but firmly until the connector is fully inserted.

- Don't rock the card from side to side; instead, press the card straight into the slot.
- Don't force the card. If you meet a lot of resistance, pull the card out. Check the connector and the slot for damage or obstructions, then try inserting the card again.
- Pull the card gently to see if it is properly connected. If it resists and stays in place, and if its gold connectors are barely visible, the card is connected.

5 Reinsert the port access cover screw and tighten it to hold the card in place.

**Warning:** If you remove a card and don't install a replacement, be sure to place a port access cover over the empty slot to keep foreign objects out of the enclosure. An uncovered slot affects the airflow that cools the internal components and causes damage.

6 Replace the air deflector and side panel, following the directions that begin on page 55.
Replacing the Internal Backup Battery

Your Power Mac G5 has an internal backup battery that preserves settings, such as the date and time, when the computer is off. If you notice intermittent problems when your Power Mac G5 starts up or changes in the date and time settings, you may need to replace the battery. Your Power Mac G5 uses a CR 2032 Lithium coin cell battery.

*Important:* Because batteries contain chemicals, which may be harmful to the environment, please dispose of them according to your local environmental laws.

To replace the battery:

1. Open your computer and remove the side panel and air deflector following the directions that begin on page 46.

2. Remove the old battery from the holder. If a memory module is installed in the DIMM slot next to the battery, you may have to remove it before you remove the battery.

   *Warning:* Installing the battery incorrectly may cause an explosion. Use only the same type of battery or an equivalent recommended by the manufacturer of the original.

3. Insert the new battery in the holder with the negative side (–) facing up.

4. Replace the air deflector and side panel, following the directions on page 55.
If you have a problem while working with your computer, here are some things you can try right away.

**The computer won't respond or the pointer won't move.**
First, make sure the mouse and keyboard are connected by unplugging and then plugging in the connectors, and make sure they are firmly seated.

Then try to cancel what the computer is doing.

- Press the Command (⌘) and Q keys at the same time to try to quit the current application.
- Press the Command (⌘) and period keys at the same time. If a dialog appears, click Cancel.
- Choose Apple () > Force Quit and select the application you want to quit. You can also force quit by pressing the Esc, Option, and Command (⌘) keys at the same time.Restart your Power Mac G5 by choosing Apple () > Restart to be sure the problem is entirely cleared up. You can also restart by pressing the power button ( FullName ) for about 5 seconds until your Power Mac G5 shuts down. Press the power button ( FullName ) again to start up your Power Mac G5.
- If the problem occurs only when you use a particular program, check with the program's manufacturer to see if it is compatible with your computer.
- If the problem occurs frequently, choose Help > Mac Help and search for "solve problems."
The computer won’t turn on or start up.

- Make sure the power cord is connected to a working power source. The plug on the power cord must be completely inserted into the computer’s power socket and firmly seated for your computer to operate correctly.
- If your computer still does not start up, try resetting the parameter random access memory (PRAM). Turn on the computer and immediately hold down the Command (⌘), Option, P, and R keys until you hear the startup sound a second time. Release the keys. Set your hard disk as the computer’s startup disk, by doing the following:
  1. Choose Apple () > System Preferences.
  2. Click Startup Disk.
  3. Select your hard disk.

The PRAM is reset to the default values and your clock settings may need to be reset.
- If your computer does not start up after resetting the PRAM, restart your computer while holding down the Option key to select your startup system.
- If this doesn’t work, restart your computer while holding down the Shift key.

You are unable to eject a disc.
A file on the disc may be in use. Quit applications that are open, then try again.

If that doesn’t work, choose Apple () > Restart and hold down either the mouse button or the Media Eject (⏏) key on your Apple Keyboard.

If that doesn’t work:
  1. Shut down the computer.
  2. Carefully press down the front panel covering the front of the drive tray and locate the small hole below the drive tray.
  3. Carefully insert the end of a large straightened paper clip into the hole.
  4. Push firmly until the tray opens.
  5. Pull out the tray, remove the disc, and push the tray to close it.

The status light flashes and the computer won’t start up.
- If you recently installed additional memory, a PCI expansion card, or another internal component, make sure that it is correctly installed and that it is compatible with your computer. See if removing it allows the computer to start up.
- If the status light still flashes, determine the number of flashes to identify the problem:
  - 2 flashes: no RAM installed
  - 3 flashes: incompatible RAM installed
  - 4 flashes: no good DIMM banks
  - 5 or 6 flashes: contact Apple or an Apple Authorized Service Provider
The LED lights on the logic board turn on.
Your Power Mac G5 has up to seven LED lights on the top left side of the main logic board.
If the LED lights illuminate, locate the light and use the information that follows to identify the cause:

Note: LEDs 3, 4, and 5 illuminate only when the air deflector is not in place or it is not closed properly. Your Power G5 may not have an LED 6.

- **LED 1—CPU A**: red—contact Apple or an Apple Authorized Service Provider
- **LED 2—Overtemp**: red—contact Apple or an Apple Authorized Service Provider
- **LED 3—Power On**: red—the main power is on
- **LED 4—Trickle**: yellow—Power Mac G5 is plugged into the wall correctly
- **LED 5—Open Firmware good**: green—no problem
- **LED 6—CPU B**: red—contact Apple or an Apple Authorized Service Provider
- **LED 7—Checkstop**: red—contact Apple or an Apple Authorized Service Provider

Problems With Software

Important: To use Mac OS 9 applications with your computer in the Classic environment, you must install Mac OS 9 (see “Installing Mac OS 9” on page 75). To start the Classic environment, open a Mac OS 9 application or double-click a document that requires a Mac OS 9 application. Classic works in the background to access Mac OS 9 features and software applications.

You have a problem with a software program.

- Use Software Update to ensure that you have the latest drivers, bug fixes, and other updates.
- For problems with software from a manufacturer other than Apple, contact the manufacturer.
You have a problem using your computer or working with Mac OS X.
• Look in Mac OS Help (in the Help menu) for instructions and troubleshooting information.
• Go to the Apple Support website on the Internet for the latest troubleshooting information and software updates: www.apple.com/support.

You have trouble using AirPort wireless communication.
• Make sure you have properly configured the software according to the instructions that came with your AirPort Express or AirPort Extreme Base Station.
• Make sure the computer or network you are trying to connect to is running and has a wireless access point.
• Make sure you are within antenna range of the other computer or the network’s access point. Nearby electronic devices or metal structures can interfere with wireless communication and reduce this range. Repositioning or rotating the computer may improve reception.
• Check the AirPort signal level. You may have up to four bars in the AirPort status icon in the menu bar.
• For more information, see the instructions that came with the wireless device or search for “AirPort” in Mac Help.

Problems With Your Display

**Warning:** If you have a problem with your Apple display and nothing presented in this manual solves it, contact an Apple Authorized Service Provider or Apple for assistance. If you attempt to repair the display yourself, any damage you may cause to the display will not be covered by the limited warranty on your display. Contact an Apple Authorized Reseller or Apple Authorized Service Provider for additional information about this or any other warranty question.

No image appears on the screen.
• Make sure the display and computer are turned on.
• Make sure the cables are connected properly to your computer and the display.
• Make sure your computer is not in sleep. Press the power button or any key to see if the computer wakes.
• Make sure the display brightness and contrast are set properly. Some displays have brightness and contrast controls on or under their front edges.
• Reset the PRAM by restarting the computer while holding down the Command (⌘), Option, P, and R keys until you hear the startup sound a second time. Then start up using the software installer disc that came with your computer.
The screen image appears dim or flickers.
• Adjust the display brightness and contrast settings. Some displays have brightness and contrast controls on or under their front edges. Depending on how dim your display appears, you may be able to adjust brightness or contrast using the Displays pane of System Preferences.
• Calibrate the display by choosing Apple () > System Preferences. Click Displays, select Color, and click Calibrate.
• The flickering may be caused by interference from a nearby power line, a fluorescent light, or an electrical device—for example, a radio, a microwave oven, or another computer. Try relocating nearby electrical devices or moving your computer and display.

No colors appear on the screen or the colors don’t look right.
• Make sure the display is connected firmly to the computer.
• Calibrate your display, as described previously. For more information on color and your display, see Mac Help.
• Open the Displays pane of System Preferences and make sure your display is set to display colors. For more information on color and your display, see Mac Help.

After you change the screen resolution, desktop icons move.
Changing the screen resolution affects the display of information on your screen. The operating system may reposition icons after you change the screen resolution.

The screen freezes.
• Force the application that has frozen to quit. Choose Apple () > Force Quit and select the application.
• If that doesn’t work, force the computer to restart by pressing the power button on the front of your computer for approximately 5 seconds.

The light on the front of the display is flashing.
On some Apple flat-panel displays, the power light displays a series of short flashes when an error has been detected.
• If you see a repeating sequence of three short flashes, the display is detecting input in the wrong video format. Make sure your display is compatible with your graphics card and that you’ve installed the correct display software, if your display came with installation software.
• If you see a sequence of two short flashes and a long flash, the display is detecting a problem with a backlighting lamp. Contact an Apple Authorized Reseller or Apple Authorized Service Provider.
Using Apple Hardware Test
You can use Apple Hardware Test to help determine if there is a problem with your computer’s hardware.

To use Apple Hardware Test:
1 Disconnect all external devices from your computer except the keyboard and mouse. If you have an Ethernet cable connected, disconnect it.
2 Insert the Mac OS X Install Disc 1 that came with your computer.
3 Restart your computer and hold down the Option key as it starts up.
   A list of available startup volumes appears.
4 Click Apple Hardware Test and click the right arrow.
5 Follow the onscreen instructions when the Apple Hardware Test main screen appears (after about 45 seconds).
6 Make a note of the error code before pursuing support options.
   If Apple Hardware Test detects a problem, it displays an error code. If Apple Hardware Test does not detect a hardware failure, the problem may be software-related.

For more information about Apple Hardware Test, see the Apple Hardware Test Read Me file on Mac OS X Install Disc 1.

Reinstalling the Software That Came With Your Computer
Use the software install discs that came with your computer to reinstall Mac OS X and the applications that came with your computer, and to install Mac OS 9.

Important: Apple recommends that you back up the data on your hard disk before restoring software. Apple is not responsible for any lost data.

Installing Mac OS X
To install Mac OS X:
1 Back up your important files, if possible.
2 Insert the Mac OS X Install Disc 1 that came with your computer.
3 Double-click “Install Mac OS X and Bundled Software.”
4 Follow the onscreen instructions.
5 Select the destination disk for installation and continue following the onscreen instructions.
   Your computer may restart and ask you to insert the next Mac OS X install disc.

Important: Because the “Erase and Install” option erases your destination disk, you should back up your essential files before installing Mac OS X and other applications.
Installing Applications
To install the applications that came with your computer, follow the steps below. Your computer must have Mac OS X already installed.

To install the applications:
1. Back up your important files, if possible.
2. Insert the Mac OS X Install Disc 1 that came with your computer.
3. Double-click “Bundled Software.”
4. Follow the onscreen instructions.
5. Select the destination disk for installation and continue following the onscreen instructions.

To install iCal, iChat, iSync, iTunes, and Safari, follow the “Installing Mac OS X” instructions above.

Installing Mac OS 9
Your computer does not come with Mac OS 9 installed. To use Mac OS 9 applications with your computer, you have to install Mac OS 9 using the Mac OS X Install Disc 2.

To install Mac OS 9:
1. Back up your important files, if possible.
2. Insert the Mac OS X Install Disc 2 that came with your computer.
3. Double-click “Install Mac OS 9 System Support.”
4. Follow the onscreen instructions.
5. Select the destination disk for installation and continue following the onscreen instructions.

Maximizing Ethernet Performance
Your computer performs best when the Ethernet port to which it is connected is set to auto-negotiate. Ask your network administrator to verify this setting.

Important: If you experience connection problems on your network, make sure your network switch is set to auto-negotiate, if possible. If a switch’s port is not auto-negotiating, your computer detects the appropriate speed but defaults to half-duplex mode. If the switch’s port at the other end of the link is configured for full-duplex mode, a large number of late events can occur on the link. If it isn’t possible to set the switch to auto-negotiate, then set the switch’s port to half-duplex. For more information, see the documentation that came with the Ethernet switch.
Note: If you connect your computer directly to a configurable Ethernet switch, have your network administrator disable spanning tree on that port. Otherwise your computer may duplicate the AppleTalk address of another computer on the same network and both network connections may become unreliable.

Locating Your Product Serial Number
System Profiler shows the serial number of your computer. Open System Profiler (in Applications/Utilities) and click the System Profile tab.

The serial number of your Power Mac G5 is also on the configuration label, which is located inside the side panel, directly below the air deflector.
Specifications

Processor and Memory Specifications

Processor
- PowerPC G5 dual core processor
- 1 megabyte (MB) of on-chip L2 cache per processor

Random-access memory (RAM)
- Double-Data-Rate 2 (DDR2) synchronous dynamic random-access memory (SDRAM)
- All DDR2 SDRAM supplied in removable dual inline memory modules (DIMMs)
- PC2-4200, 533 MHz DIMMs, also known as DDR2-533
- DIMMs must be installed in pairs of equal size and equal specification
- Eight DIMM slots available:
  - 256 MB DIMMs must have 128 or 256 megabit (Mbit) technology devices
  - 512 MB DIMMs must have 256 Mbit technology devices
  - 1 GB DIMMs must have 512 Mbit technology devices
- Error-correcting code (ECC) or no error-correcting code (NECC) modules. Do not mix ECC and NECC memory modules within a pair.
- 64-bit wide, 240-pin modules
- 18 memory devices maximum per DIMM
- Conform to JEDEC specification (see page 51)
- Unbuffered (not registered or buffered)
- Maximum height of 1.25 inches
- Nonparity

System Profiler, located in Applications/Utilities, provides information about your computer, including the amount of memory.

Graphics Card
PCI Express graphics card with two Digital Visual Interface (DVI) connectors. The total combined maximum video random access memory (VRAM) for all graphics cards is 1 GB.
Video Display Modes
For technical specifications for your display:

- **Apple displays**: Go to the Apple website and check the specifications for your product at www.apple.com/displays.
- **Non-Apple displays**: Go to www.apple.com/guide.

SuperDrive (DVD+R DL/DVD±RW/CD-RW) Specifications
- **Disc diameters supported**: 12 cm and 8 cm

Data formats
- CD-ROM
- CD-Audio
- CD-R
- CD-RW
- CD-I
- CD-I Bridge
- CD Extended
- CD Mixed Mode
- Photo CD
- Video CD
- Enhanced CD
- DVD-Video
- DVD±R
- DVD±RW
- DVD+R DL

USB Specifications
- Support for Universal Serial Bus (USB) 2.0 and 1.1
- Five external USB Type A ports
  - One USB 2.0 port on the front
  - Three USB 2.0 ports on the back
  - Two USB 1.1 ports on the Apple Keyboard
- Each rear port is on a separate 480 megabit-per-second (Mbps) USB channel
- 500 milliamperes (mA) at 5 V are available for each USB 2.0 port, for a total of 1.5 amperes

FireWire Specifications
- Support for FireWire 400 and FireWire 800
- Three external FireWire ports
  - One FireWire 400 port on the front
• One FireWire 400 and one FireWire 800 port on the back
• Data transfer speed:
  • FireWire 400: 100, 200, and 400 Mbps
  • FireWire 800: 100, 200, 400, and 800 Mbps

Power
• Output voltage: Approximately 24 to 26 V
• Output power: Up to a maximum 37.5 W for all 3 ports or 25 W for any one port

Ethernet Specifications
• IEEE 802.3 compliant
• Maximum cable length: 100 meters (m)
• Protocols: Open Transport, AppleShare, AppleTalk, NetWare for Macintosh, TCP/IP
• Connector: RJ-45 for 10Base-T, 100Base-TX, and 1000Base-T
• Media, 10Base-T: Category (CAT) 3 or higher UTP on 2 pairs up to 100 m
• Media, 100Base-TX: CAT 5-e UTP on 2 pairs up to 100 m
• Media, 1000Base-T: CAT 5-e UTP on 4 pairs up to 100 m
• Channel speeds: IEEE Auto Negotiation of 10Base-T, 100Base-TX, and 1000Base-T

Bluetooth Specifications (Optional)
• Wireless data rate: Up to 3 Mbps
• Range: Up to 10 meters or 33 feet (data rates may vary depending on environmental conditions)
• Frequency band: 2.4 gigahertz (GHz)

AirPort Extreme Specifications (Optional)
• Wireless data rate: Up to 54 Mbps
• Range: Up to 150 feet (data rates may vary depending on environmental conditions)
• Frequency band: 2.4 gigahertz (GHz)
• Radio output power: 15 dBm (nominal)

Compatibility
• 802.11 Direct Sequence Spread Spectrum (DSSS) 1 and 2 Mbps standard
• 802.11b 11Mbps standard
• 802.11g 54 Mbps standard
Optical Digital Audio Specifications
- **Data format**: Sony/Phillips Digital Interface (S/PDIF) protocol (IEC60958-3)
- **Connector type**: Toslink optical (IEC60874-17)
- **Bits per sample**: 16-bit or 24-bit

Optical digital audio out
Based on a typical situation with playback of a 1KHz, -1dBFS 24-bit sine wave, 44.1KHz output sample rate, unless otherwise specified below.
- **Output sample rate**: 32 kHz, 44.1 kHz, 48 kHz, 64 kHz, 88.2 kHz, or 96 kHz
- **Signal-to-noise ratio**: Greater than 130 dB
- **Total harmonic distortion + noise**: Less than -130 dB (0.00001 percent)

Optical digital audio in
Based on a typical situation with playback of a 1KHz, -1dBFS 24-bit sine wave, unless otherwise specified below.
- **Fsi–input sample rate (external clock mode)**: 32 kHz, 44.1 kHz, 48 kHz, 64 kHz, 88.2 kHz, or 96 kHz
- **Fsi–input sample rate (internal clock mode)**: 32 kHz, 44.1 kHz, 48 kHz, 64 kHz, 88.2 kHz, or 96 kHz
- **Signal-to-noise ratio (external clock mode)**: Greater than 130 dB
- **Signal-to-noise ratio (internal clock mode, 16 kHz < Fsi < 96 kHz)**: Less than -112 dB
- **Total harmonic distortion + noise (external clock mode)**: Less than -130 dB (0.00001%)
- **Total harmonic distortion + noise (internal clock mode, 16 kHz < Fsi < 96 kHz)**: Less than -112 dB (0.0003%)

Analog Audio Specifications
- **Sample rate**: 32 kHz, 44.1 kHz, 48 kHz, 64 kHz, 88.2 kHz, or 96 kHz
- **Jack type**: 1/8" mini
- **Bits per sample**: 16-bit or 24-bit
- **Frequency response**: 20 Hz to -20 kHz, +0.5 dB/-3 dB

Sound out using the headphone jack
- **Output voltage**: 1.4 volts (root mean square) ($V_{rms}$) (+4 dBµ)
- **Output impedance**: 24 ohms
- **Output power**: 90 milliwatts (mW)
- **Signal-to-noise ratio**: Greater than 90 dB
- **Total harmonic distortion**: Less than -80 dB (0.01 percent)
- **Channel separation**: Greater than 65 dB

Analog audio line-in
- **Maximum input voltage**: $2V_{rms}$ (+8 dBµ)
- **Input impedance**: Greater than 47 kilohms
• **Signal-to-noise ratio**: Greater than 90 dB
• **Total harmonic distortion**: Less than -85 dB (0.006 percent)
• **Channel separation**: Greater than 75 dB

**Analog audio line-out**
• **Output voltage**: 1.4 Vrms (+4 dBµ)
• **Output impedance**: 24 ohms
• **Signal-to-noise ratio**: Greater than 90 dB
• **Total harmonic distortion**: Less than -80 dB (0.01 percent)
• **Channel separation**: Greater than 65 dB

**Power Supply**

**AC line input**
• **Voltage ranges**: 100–120 V alternating current (AC) and 200–240 VAC
• **Current**: Maximum of 12 amperes (A) (low voltage range) or 6 A (high voltage range)
• **Frequency**: 50–60 Hz

**DC display output**
Dependent on video card

**Power Requirements for Devices You Can Connect**

**Expansion cards**
Combined maximum power consumption for all four PCI Express slots should not exceed 200 watts (W).

**USB devices**
Each of the computer’s built-in USB ports is allotted 500 mA.

**FireWire devices**
The computer can provide up to 37.5 W total to the FireWire ports.

**System Clock and Battery**
Your computer has CMOS custom circuitry with a long-life battery.

**Battery**
Use a 3 V, CR 2032 Lithium coin cell replacement battery (see “Replacing the Internal Backup Battery” on page 68).
Dimensions and Operating Environment

Dimensions

- **Weight**: 21.6 kg (47.6 lbs.)
  
  Weight depends on configuration. The weight above is for a basic configuration and may be greater if optional devices are installed.

- **Height**: 511 mm (20.12 in.)
- **Width**: 206 mm (8.11 in.)
- **Depth**: 475 mm (18.70 in.)

Operating environment

- **Operating temperature**: 10° to 35° C (50° to 95° F)
- **Storage temperature**: –40° to 47° C (–40° to 116° F)
- **Relative humidity**: 5% to 95% (noncondensing)
- **Altitude**: 0 to 3048 meters (0 to 10,000 feet)
Safety, Maintenance, and Ergonomics

This appendix provides important information about safety procedures, routine maintenance, and ergonomic considerations for using your computer and display.

Important Safety Information
The only way to disconnect power completely from your computer is to unplug the power cord from the main power supply. To disconnect your display completely, you must also unplug its power cable from the computer or power outlet. Make sure that at least one end of the device's power cord is within easy reach so that you can unplug the computer or display when necessary.

For your own safety and that of your equipment, always take the following precautions.
Disconnect the power plug (by pulling the plug, not the cord), from your computer or display and disconnect the phone cord if any of the following conditions exists:

• The power cord or plug becomes frayed or otherwise damaged
• You spill something into the case
• Your computer or display is exposed to rain or any other excess moisture
• Your computer or display has been dropped or the case has been otherwise damaged
• You suspect that your computer or display needs service or repair
• You want to clean the computer or display case or screen
• You notice a coolant leak in or from your computer (for Power Mac G5 models equipped with a liquid cooling system)
• If you plan to store your computer for an extended period of time, remove the battery.

⚠️ **Warning:** To prevent accidents and damage to your computer or display, be sure that you always follow these instructions:

- Keep your computer and display away from sources of liquids and moisture.
- Don’t set anything on top of the computer or display.
- Keep the computer and display vents free from obstruction.
- Never remove the case from the display or open your computer when it’s running. You could come in contact with hazardous voltage.
- During lightning storms, disconnect your modem from the phone jack to prevent damaging the modem with a destructive voltage overload.

Your Macintosh is equipped with a three-wire grounding plug—a plug that has a third grounding pin. This is a safety feature. Don’t modify the plug to fit into an ungrounded outlet. Contact a licensed electrician to replace the outlet with a properly grounded one. Do not defeat the purpose of the grounding plug!

Be careful when lifting or moving your computer or display. Be sure to use correct lifting procedures, lifting with your legs. When carrying the display, make sure the display is facing you. Don’t carry the display by its stand. Be careful when lifting or moving your computer or display. Be sure to use correct lifting procedures, lifting with your legs. When carrying the display, make sure the display is facing you. Don’t carry the display by its stand.

Electrical equipment may be hazardous if misused. Operation of this product by children must always be supervised by an adult. Do not allow children access to the interior of any electrical product and do not permit them to handle any cables.

**Liquid Cooling System**
Some Power Mac G5 models use a liquid cooling system to manage the temperature in the computer. The liquid cooling system is sealed and is designed to be opened only by an Apple Authorized Service Provider (AASP).

⚠️ **Warning:** Do not attempt to open or service the liquid cooling system. Opening the liquid cooling system may damage your equipment, and such damage may not be covered by the limited warranty on your computer.
For service or questions about your warranty, contact an Apple Authorized Service Provider or Apple. Service and support information is included with your computer’s documentation.

Apple and the Environment
At Apple, we recognize our responsibility to minimize the environmental impacts of our operations and products.

For more information, go to www.apple.com/environment/summary.html.

General Maintenance
If you need to clean the computer or display beyond wiping it down with a clean cloth, follow these instructions:

1. Turn off your computer and display.
2. Disconnect the computer power cable from the electrical outlet or power strip. If your display is connected to an outlet, disconnect it as well.
3. Disconnect the display’s cables from the computer.
4. Clean the display screen with soft, lint-free paper or cloth dampened with mild soap and water.

**Warning:** Do not spray liquid directly onto the display screen. Liquid could drip inside the display and cause electrical shock.

5. Wipe the computer or display case surfaces lightly with a clean, soft cloth dampened with water.

**Important:** Don’t use alcohol, aerosol sprays, solvents, or abrasives that might damage the finish on the case.
Protecting Your Optical Drive
To keep your optical drive working properly:
- Position your computer so that the drive tray doesn't bump into anything when it opens.
- Close the drive when you’re not using it.
- Do not put anything on the drive tray when it is open.
- Do not touch the optical drive lens with your fingers. Do not wipe the lens with a paper towel or other abrasive surface. If you need to clean the lens, see an Apple Authorized Service Provider for a lens cleaner.
- Keep your computer away from any source of moisture.

Maintaining Your Display
To maintain your display and ensure its long life:
- Do not press on the surface of the display screen.
- Do not write on the screen or touch the screen with a sharp object.
- If you will not be using your display and computer for a day or more, turn off the computer and display or use Energy Saver.
- Turn off your display, turn down the brightness, or use a screen saver program that dims or varies the image on the screen when the computer is idle for a prolonged time.

Important Ergonomic and Health-Related Information
Here are some guidelines for adjusting the furniture in your office to reduce glare and to accommodate your physical size and shape.
- An adjustable chair that provides firm, comfortable support is best. Adjust the height of the chair so your thighs are tilted slightly and your feet are flat on the floor. The back of the chair should support your lower back (lumbar region). Follow the manufacturer's instructions for adjusting the backrest to fit your body properly.
- When you use the computer keyboard, your shoulders should be relaxed. Your upper arm and forearm should form an approximate right angle, with your wrist and hand in roughly a straight line.
  You may have to raise your chair so that your forearms and hands are at the proper angle to the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a footrest with adjustable height and tilt to make up for any gap between the floor and your feet. Or you can lower the desktop to eliminate the need for a footrest. Another option is to use a desk with a keyboard tray that's lower than the regular work surface.
- Position the mouse at the same height as your keyboard. Allow adequate space to use the mouse comfortably.
• Arrange the display so that the top of the screen is slightly below your eye level when you’re sitting at the keyboard. The best distance from your eyes to the screen is up to you, although most people seem to prefer 18 to 28 inches (45 to 70 cm).
• Position the display to minimize glare and reflections on the screen from overhead lights and nearby windows. If possible, use a tiltable display stand. The stand lets you set the display at the best angle for viewing, helping to reduce or eliminate glare from lighting sources you can’t move.

For more information about health, safety, and maintenance, go to the Apple ergonomic website at www.apple.com/about/ergonomics.

Avoid Hearing Damage

**Warning:** Permanent hearing loss may occur if earbuds or headphones are used at high volume. You can adapt over time to a higher volume of sound that may sound normal but can be damaging to your hearing. If you experience ringing in your ears or muffled speech, then stop listening and have your hearing checked. The louder the volume, the less time required before your hearing can be affected. Hearing experts suggest that to protect your hearing:

• Limit the amount of time you use earbuds or headphones at high volume
• Avoid turning up the volume to block out noisy surroundings
• Turn the volume down if you can’t hear people speaking to you
Connecting to the Internet

You can use your computer to browse the World Wide Web, send email to friends and family, and chat in real time over the Internet. Use this detailed guide to connect to the Internet.

When you first start up Mac OS X, Setup Assistant helps you enter your Internet configuration information.

If you didn’t use Setup Assistant to configure your Internet connection, you can use it now. Open System Preferences and click Network. Click the “Assist me” button to open Network Setup Assistant. If you don’t want to use Network Setup Assistant, you can use the information in this appendix to set up your connection manually.

There are four kinds of Internet connections:
- **Dial-up connection:** An external modem is plugged into a USB port on your computer and a telephone cable connects the modem to a telephone wall jack.
- **High-speed DSL or cable modem connection:** Your computer is plugged into a special modem you get from an ISP using an Ethernet cable.
- **AirPort Extreme wireless connection:** Your computer is connected wirelessly to the Internet using an AirPort Extreme or AirPort Express Base Station.
- **Local area network (LAN):** Your computer is plugged into a LAN using an Ethernet cable. This type of connection is usually used in the workplace.

Before you connect to the Internet:
1. Set up an account with an ISP. You can find an ISP in your phone directory. Look under “Internet access,” “Internet service,” or “online.”

   **Note:** If you want to use America Online as your ISP, skip the Internet setup part of Setup Assistant. You need the AOL Installer application. Open the AOL Installer application and follow the onscreen instructions to set up AOL.

2. Gather the connection information you need from your ISP or network administrator. In some cases, if another computer in the same location is already connected to the Internet, you may be able to use its settings.
To find the settings on a Mac OS X computer:
- Open the Network pane of System Preferences.
- Choose your connection method from the Show pop-up menu.
- Copy the information for your configuration.

To find the settings on a Mac OS 9 computer:
- Open the TCP/IP control panel.
- Find the connection method in the “Connect via” pop-up menu.
- Find the configuration in the Configure pop-up menu.
- Copy the IP address, subnet mask, and router address from the corresponding fields.

To find the settings on a Windows PC:
The connection information on a Windows computer resides in two places.
- To find the IP address and subnet mask, open the “Network and Internet Connections” control panel.
- To find user account information, open the User Accounts control panel.
You can write the information directly on the next few pages, then enter it in Setup Assistant.

3 If you are using an external modem, plug the modem into a USB port on your computer, and plug a phone cord into the port on the modem and into a phone wall jack. If you are using a DSL or cable modem, follow the instructions that came with the modem to connect it to your computer.

4 Turn on your computer and enter information in Setup Assistant to configure your Internet connection.

Note: If you already started your computer and did not use Setup Assistant to configure your Internet connection, choose Apple () > System Preferences and click Network. Then click “Assist me.” Setup Assistant opens.

Gathering the Information You Need
You can write the information you get from your Internet service provider (ISP), your network administrator, or your other computer on these pages, then enter it in Network Setup Assistant.

To set up a telephone dial-up connection, gather the following information:
- Service provider name
- User or account name
- Password
- ISP phone number
- Alternate phone number
- Dialing prefix to obtain an outside line
To set up a DSL, cable modem, LAN, or AirPort Extreme wireless connection:

- First, choose your connection method (ask your system administrator or your ISP, if you don't know):
  - Manually
  - Using DHCP with a manual address
  - Using DHCP
  - Using BootP
  - PPP

If you're unsure which method to use, "Using DHCP" may be a good choice, because the network supplies most of the required information for you automatically.

If you selected “Manually” or “Using DHCP with a manual address,” gather the following:
- IP address
- Subnet mask
- Router address
  
  **Note:** If you selected “Using DHCP with a manual address,” you don’t need a subnet mask or router address.

If you selected “Using DHCP,” gather the following optional information (ask your ISP if you need it):
- DHCP client ID
- DNS servers

If you selected “PPP” (for PPPoE connections), gather the following:
- Service provider
- Account name
- Password
- PPPoE service name

The information below is optional. Ask your ISP or system administrator if you need it.
- DNS servers
- Domain name
- Proxy server
Enter your information:
After gathering your specific setup information from your ISP or network administrator, you can click the “Assist me” button in the Network preferences pane to open Network Setup Assistant, or you can enter the information manually.

To enter your information manually, follow the steps that correspond to your connection method.
- Dial-up modem with Point-to-Point Protocol (PPP) connection (see page 92)
- Cable modem, DSL, or LAN connection (page 95) using these configurations:
  - Manual
  - DHCP
  - PPPoE
- AirPort Extreme wireless connection (see page 99)

Dial-Up Connection
A dial-up modem is a common way to connect to the Internet. A modem uses a method called Point-to-Point Protocol (PPP) to connect to an ISP.

Make sure your external modem is plugged securely into a USB port on your computer and into a phone line. Have the information from your ISP available.

To set up Network preferences for the internal modem port:
1. Choose Apple () > System Preferences from the menu bar.
2. Click Network.
3. Choose Network Port Configurations from the Show pop-up menu and select the On checkbox next to External Modem.

4. Drag External Modem to the top of the Port Configurations list to make it the preferred, or primary, network interface.

5. Choose External Modem from the Show pop-up menu and click PPP.

6. Enter the information from your ISP and click Apply Now.
To test your Internet configuration:
1. Open the Internet Connect application (in the Applications folder).
2. Click the External Modem icon, if necessary.
3. Enter your dial-up telephone number, account name, and password, if necessary.
4. Click Connect.

Internet Connect dials your ISP and establishes a connection.

To connect automatically when you start an Internet application, such as a web browser or email:
1. Click PPP Options (in the PPP pane of Network preferences).
2. Select the “Connect automatically when needed” checkbox.

3. Click OK and Apply Now.

DSL, Cable Modem, or LAN Internet Connections

If you connect to the Internet using a DSL or cable modem or Ethernet LAN, ask your ISP or network administrator how you should configure your Internet connection:

- **Manually:** With a manual configuration, your ISP or network administrator provides a static IP address and other information that you enter in Network preferences.
- **Using Dynamic Host Configuration Protocol (DHCP):** With a DHCP configuration, the DHCP server automatically enters the information for you.
- **Using Point-to-Point Protocol over Ethernet (PPPoE):** If you use a DSL modem and need a user name and password to connect to the Internet, you may need to configure your network to use PPPoE.
Make sure you have the information from your ISP available as you configure your network.

**To set up Network preferences for the built-in Ethernet port:**
1. Choose Apple () > System Preferences from the menu bar.
2. Click Network.
3. Choose Network Port Configurations from the Show pop-up menu.
4. Select the On checkbox next to Built-in Ethernet.
5. Drag Built-In Ethernet to the top of the Port Configurations list to make it the preferred, or primary, network interface.

Next, follow the instructions to configure your network manually, using DHCP, or using PPPoE, as instructed by your ISP or network administrator.

**Manual Configuration**
Have your static IP address, router address, and subnet mask from your ISP ready.

**To set up a manual configuration:**
1. In Network preferences, choose Built-in Ethernet from the Show pop-up menu.
2. Click TCP/IP, if necessary.
3 Choose Manually from the Configure IPv4 pop-up menu.

4 Type the other information into the corresponding fields.

5 Click Apply Now.

Once you configure your network, your connection is ready. Open your web browser (or another TCP/IP application) to test your Internet connection.

**DHCP Configuration**

After you set up a DHCP configuration, the DHCP server automatically provides your network information.

To set up a DHCP configuration:

1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.

2 Click TCP/IP, if necessary.
Choose Using DHCP from the Configure IPv4 pop-up menu.

![Network preferences settings](image)

Click Apply Now.

Open your web browser (or another TCP/IP application) to test your Internet connection.

**Note:** Unless your ISP instructs you to do otherwise, ignore the DHCP Client ID field and the Search Domains field.

**PPPoE Configuration**

Some DSL-based ISPs use Point-to-Point Protocol over Ethernet (PPPoE). If you use a DSL modem and need a user name and password to connect to the Internet, check with your ISP to determine if you should connect using PPPoE.

To set up a PPPoE connection:

Have your user name, password, and if required, the domain name server (DNS) address from your ISP available as you configure your network.

1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.
2 Click PPPoE and select “Connect using PPPoE.”

3 Type the information into the corresponding fields. If you want all users of your computer to use the same connection method, select “Save password.”

*Note:* To connect automatically when you start a TCP/IP application, such as a web browser or email, click PPPoE Options, then select “Connect automatically when needed” and click OK.
4 Click TCP/IP and choose either Using PPP or Manually from the Configure IPv4 pop-up menu, as instructed by your ISP. If you have a static IP address from your ISP, choose Manually and type the address in the IP Address field.

5 Type the domain name server (DNS) addresses in the DNS Servers field.

6 Click Apply Now.

Once you configure your network, your Internet connection is ready. You can open your web browser or other TCP/IP application to test your connection.

**Important:** If you did not select the option to connect automatically, you will need to open the Internet Connect application, choose the correct configuration, and then click Connect. For more information, choose Help > Internet Connect Help from the menu bar at the top of the display.

**AirPort Wireless Connection**

If your Power Mac G5 has AirPort Extreme installed, you can configure your AirPort network and Internet connection using AirPort Setup Assistant, located in the Utilities folder within your Applications folder. The assistant helps you configure the AirPort Base Station and set up your computer to use AirPort. For more information about your AirPort Base Station, see the *AirPort Base Station Setup Guide* that came with your base station.

If your AirPort Base Station is already configured, in most cases your AirPort Extreme technology is ready for immediate access.
To check if you have access to an AirPort network:

- Click the AirPort status icon in the menu bar and choose an AirPort network.

If you don’t see an AirPort network listed, you can use AirPort Setup Assistant to check or change your settings, or you can change them using the Network pane of System Preferences.

**Setting Up an AirPort Connection Manually**

Gather the following information from your system administrator if you’ll be setting up a manual connection.

- Domain name server (DNS) addresses, if necessary
- DHCP or manual IP address configuration
- IP address
- Router address
- Subnet mask
- Password, if required

Next, make sure your AirPort connection options are active in Network preferences.

**To set up Network preferences for an AirPort connection:**

1. Choose Apple () > System Preferences from the menu bar.
2. Click Network.
3. Choose Network Port Configurations from the Show pop-up menu.
4 Select the On checkbox next to AirPort.

Next, follow the instructions to configure your network either manually or using DHCP, as instructed by your ISP or network administrator. If you’re setting up your network yourself, it may be easier to configure the network using DHCP, because the server assigns IP addresses automatically.

5 Choose AirPort from the Show pop-up menu.

6 Click TCP/IP, if necessary.

7 In the Configure IPv4 pop-up menu, choose either Manually or Using DHCP.
• If you chose Manually, type the other information into the corresponding fields.
• If you chose Using DHCP, you don’t need to enter any further information unless your system administrator has instructed you to do so.

8 Click AirPort and select options for joining an AirPort Extreme network after restarting or when your computer wakes from sleep.

9 Click Apply Now.

Once you configure your AirPort settings, you are ready to connect.

To test your AirPort connection:

Click the AirPort status icon in the menu bar and choose Turn AirPort On. Any AirPort Extreme network in range should appear in the menu.

Troubleshooting Your Connection

Cable Modem, DSL, and LAN Internet Connections
If you can’t connect to the Internet using your AirPort, built-in Ethernet, or external modem, you can use Network Diagnostics to diagnose connection problems. Click “Assist me” in the network pane of System Preferences, click Diagnostics, and follow the onscreen instructions.

If Network Diagnostics can’t resolve the problem, there may be a problem with the Internet service provider (ISP) you are trying to connect to, with an external device you are using to connect to your ISP, or with the server you are trying to access. You can also try the following steps:

Check the cables and power supplies
Make sure all modem cables are firmly plugged in, including the modem power cord, the cable from the modem to the computer, and the cable from the modem to the wall jack. Check the cables and power supplies to Ethernet hubs and routers.

Turn the modem on and off and reset the modem hardware
Turn off your DSL or cable modem for a few minutes, then turn it back on. Some ISPs recommend that you unplug the modem’s power cord. If your modem has a reset button, you can press it either before or after you turn the power off and on.

PPPoE Connections
If you are unable to connect to your Internet service provider using PPPoE, first check the cables and power supplies, then turn the power off and on and reset the modem hardware.
Check System Preferences settings:
1 Choose Apple () > System Preferences.
2 Click Network.
3 Choose Network Port Configurations from the Show pop-up menu.
4 Drag Built-in Ethernet to the top of the Port Configurations list.
5 Choose Built-in Ethernet from the Show pop-up menu.
6 Click PPPoE.
7 Select “Connect using PPPoE.”
8 Check the Account Name field to be sure you have entered the correct information from your ISP.
9 Retype your password if you chose to save your password, to be sure it is correct.
10 Click TCP/IP. Make sure you've entered the correct information from your ISP in this pane.
11 Click Apply Now.

Network Connections
If you have two or more computers attempting to share an Internet connection, be sure that your network is set up properly. You need to know if your ISP provides only one IP address or if it provides multiple IP addresses, one for each computer.

If only one IP address is used, then you must have a router capable of sharing the connection, also known as network address translation (NAT) or “IP masquerading.” For setup information, check the documentation provided with your router or ask the person who set up your network. The AirPort Extreme Base Station may be used to share one IP address among multiple computers. For information on using the AirPort Extreme Base Station, check the onscreen help or visit the Apple AirPort website at www.apple.com/airport.

If you cannot resolve the issue using these steps, contact your ISP.
Communications Regulation Information

FCC Compliance Statement
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.

Radio and Television Interference
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

If necessary, consult an Apple Authorized Service Provider or Apple. See the service and support information that came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions.

Important: Changes or modifications to this product not authorized by Apple Computer, Inc., could void the EMC compliance and negate your authority to operate the product.

This product has demonstrated EMC compliance under conditions that included the use of compliant peripheral devices and shielded cables between system components. It is important that you use compliant peripheral devices and shielded cables (including Ethernet network cables) between system components to reduce the possibility of causing interference to radios, television sets, and other electronic devices.

Responsible party (contact for FCC matters only):
Apple Computer, Inc. Product Compliance,
1 Infinite Loop M/S 26-A
Cupertino, CA 95014-2084

AirPort Extreme and Bluetooth Wireless Information

FCC Bluetooth Wireless Compliance
The antenna used with this transmitter must not be colocated or operated in conjunction with any other antenna or transmitter subject to the conditions of the FCC Grant.

Bluetooth Industry Canada Statement
This Class B device meets all requirements of the Canadian interference-causing equipment regulations.

Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Bluetooth Europe—EU Declaration of Conformity
This wireless device complies with the specifications EN 300 328, EN 301-489, and EN 60950 following the provisions of the R&TTE Directive.

Industry Canada Statement
This Class B device meets all requirements of the Canadian interference-causing equipment regulations.

Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

VCCI Class B Statement

Europe - EU Declaration of Conformity

Laser Information

Warning: Making adjustments or performing procedures other than those specified in your equipment's manual may result in hazardous radiation exposure.

Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider.
Because of the optical disc drive in your computer, your computer is a Class 1 laser product. The Class 1 label, located in a user-accessible area, indicates that the drive meets minimum safety requirements. A service warning label is located in a service-accessible area. The labels on your product may differ slightly from the ones shown here.

Exposure to Radio Frequency Energy
The radiated output power of the optional AirPort Extreme is far below the FCC radio frequency exposure limits. Nevertheless, it is advised to use the wireless equipment in such a manner that the potential for human contact during normal operation is minimized.

Mouse and Keyboard Information
The Apple optical mouse is a Class 1 LED product. This product complies with the requirements of European Directives 72/23/EEC and 89/336/EEC. It also complies with the Canadian ICES-003 Class B Specification.

High-Risk Activities Warning
This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or communications systems, or air traffic control machines, or for any other uses where the failure of the computer system could lead to death, personal injury or severe environmental damage.

ENERGY STAR® Compliance
As an ENERGY STAR® partner, Apple has determined that standard configurations of this product meet the ENERGY STAR® guidelines for energy efficiency. The ENERGY STAR® program is a partnership with office product equipment manufacturers to promote energy-efficiency. Reducing energy consumption of office products saves money and reduces pollution by eliminating wasted energy.

Disposal and Recycling Information
Dispose of your Power Mac G5 and its battery according to your local environmental laws and guidelines.
For information about Apple’s recycling program, go to www.apple.com/environment/summary.html.

European Union: This symbol means that according to local laws and regulations, your product should be disposed of separately from household waste. When this product reaches its end of life, take it to a collection point designated by local authorities. Some collection points accept products for free. The separate collection and recycling of your product at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment.

Nederlands: Gebruikte batterijen kunnen worden ingeleverd bij de chemokar of in een speciale batterijcontainer voor klein chemisch afval (kca) worden gedeponeerd.


Taiwan:
Index

A
adapter
  DVI to ADC 7
  DVI to Composite 7
  DVI to VGA 7
air deflector 49
AirPort Extreme 79
  antenna 17
  base station 40
  card 39
  connection 92
  setting up 99
  setting up a connection 91
  wireless networking 39
analog audio 35, 80
  line-in 17, 80
  line-out 17, 80
applications
  freeze 22
B
battery 19
  replacing 68
Bluetooth 41, 43, 79
  antenna 17
  file exchange 42
  keyboard 41
  module not user-installable 42
  mouse 41
  pairing 41
  sending a file 42
  setting up a device 41
C
cable modem 94
  setting up 91
CD-RW 78
changing
  the desktop 20
  System Preferences 20
computer won’t turn on 70
connecting
TV 29
VCR 29
  video device 29
D
Dashboard 20
DDR2 SDRAM 19, 51
desktop, customizing 20
DHCP 92
  configuration 96
dial-up
  connection 92
  modem 92
dial-up connection 89
dimensions 82
DIMMs 51
discharge static 46
display 29, 78
  extended desktop 28
  mirroring 28
  multiple 28
disposal and recycling 106
Dock 21
downloading software 23
DSL 92, 94
  modem 91
DVD 78
DVI port 17
Dynamic Host Configuration Protocol (DHCP) 94
E
eject disc 35
  ergonomic information 86
Ethernet 17, 37, 75, 79
  Exposé 20
F
FireWire 15, 17, 32, 78
  FireWire Target Disk Mode 33
  Force Quit 22, 73
  front fan assembly 50
  frozen application 22
<table>
<thead>
<tr>
<th>Page Dimensions: 612.0x792.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>108</td>
</tr>
</tbody>
</table>

**G**
- general maintenance 85

**H**
- hard disk drive 19
- headphone jack 15, 35, 80

**I**
- iDVD 37
- installing applications 75
  - Classic support 75
  - Mac OS 9 75
  - Mac OS X 75
- memory 51
- PCI Express cards 66
- PCI Express graphics card 65
- Serial ATA drives 58
- SuperDrive 60

**Internet**
- configuration 94
- connecting to 11, 99
- problems connecting 102

**K**
- keyboard 26
- keyboard extender cable 9

**L**
- LAN 94
  - connection 91, 92
  - latch 17, 57
  - LED lights 71
- liquid cooling system 84

**M**
- Mac OS X
  - learning about 20
  - maintenance 85
- manual Internet configuration 95
- manually using DHCP router option 91
- Material Safety Data Sheet 85
- Mighty Mouse 27
- modem
  - cable 89
  - DSL 89
  - multiple displays 28

**N**
- network connections 103
- Network Setup Assistant 89
- no image on screen 72

**O**
- operating environment 82
- operating system 20
- optical digital audio 17, 34, 80
- optical drive 15, 19, 35, 57

**P**
- PCI Express expansion slots 19
- PCI Express graphics 19
- PCI Express graphics card
- PCI Express expansion card 65
- PCI slots 17, 19
- Point-to-Point Protocol 92, 94, 97
- power button 9, 15
- power cord 6
- power socket 17
- PPPoE 92
  - configuration 97
  - connections 91
- preferences. See System Preferences
- Print & Fax preferences 24
- printing setup 24
- problems
  - connecting to Internet 102
  - processor 77
  - protective film 5

**R**
- reset the PRAM 70
- ribbon cable 61

**S**
- safety 83
- safety information 83
- screen freezes 73
- SDRAM 77
- Serial ATA drive 57
- serial number 76
- setting up 91
  - a printer 24
  - to connect manually 92
- shut down 12, 46
- shut off power 6
- sleep 12, 15
- software
  - updating 23
  - Software Update preferences 23
- Spotlight 20
- static IP address 95
- status light 15, 70
Index

stopping an application 22
SuperDrive 15, 19
System Preferences
  customizing the desktop 20
  Print & Fax 24
  Software Update 23

T
telephone dial-up connection 90

testing your Internet configuration 94

U
unable to eject a disc 70
updating software 23
USB 9, 15, 17, 30, 78, 81
using DHCP option 91

W
wireless networking and Internet access 39